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Product description

The QuantStudio™ Design and Analysis GC Software v1.0 allows the user to open, run, and analyze
experiments generated with QuantStudio™ 1 Plus Real-Time PCR Instrument. The software also allows
you to set up templates, send templates to the instrument, collect data, and analyze the collected data.
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Features in the software

Features in the software

Actions Unlocked template | Locked templatel’-2]

Properties tab

Edit experiment name; enter / scan plate barcode; enter user name v v
Select instrument / block type, experiment type, chemistry, run mode v -
Enter reagent information (chemistry details) v v
Method tab

Edit the thermal protocol, reaction volume, optical filter selection v —
Plate tab

Quick Setup subtab

Define plate attributes v —
Define or assign samples v v
Define or assign targets or SNP assays v -

Advanced Setup subtab

Define samples v v

Assign samples v v
Define targets or SNP assays v -

Assign targets or SNP assays v v
Run tab

Start and monitor a run in progress v v

View time remaining and plots!®! v v
Results tab

Review run results (analyzed run data) v v

Configure analysis settings v —
Export tab

Select export options for run data and run results (analyzed run data) v v
Export run datal®l; export template settings v v

[ If you enter the password for a locked template, all listed actions are available.
[ Always save a backup unlocked version of a template before saving it as a locked template.
B This feature is also available from the instrument touchscreen.
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Chapter 1 Product information [
Experiment types

Experiment types

Purpose

Description

Standard curve experiment

Determines absolute
target quantity in
samples.

1.

The software measures amplification of the target in a standard dilution series and in
test samples.

The software generates a standard curve using data from the standard dilution series.

The software uses the standard curve to interpolate the absolute quantity of target in
the test samples.

Relative standard curve experiment

Determines relative
target quantity in
samples.

1.

The software measures amplification of the target of interest and of an endogenous
control target in a standard dilution series, in a reference (calibrator) sample, and in test
samples.

The endogenous control is a target that is expressed equally in all samples;

examples of endogenous controls are (3-actin, GAPDH, and 18S ribosomal RNA. The
software can algorithmically incorporate multiple endogenous control targets in relative
quantification calculations.

The reference sample is used as the basis for relative quantification results (or

1x sample). For example, in a study of drug effects on gene expression, an untreated
control is an appropriate reference sample.

The software generates standard curves for the target of interest and the endogenous
control using data from the corresponding standard dilution series.

The software uses the standard curves to interpolate the quantities of the target of
interest and the endogenous control in each sample. The target quantity in each
sample is then normalized to the sample's endogenous control quantity.

To determine the relative quantity of the target in test samples, the software divides
the normalized target quantity in the sample by the normalized target quantity in the
reference sample.

Comparative C; (AAC;) experiment

Determines relative
target quantity in
samples.

1.

The software measures amplification of the target of interest and of an endogenous
control target in a reference (calibrator) sample and in test samples.

The endogenous control is a target that is expressed equally in all samples;

examples of endogenous controls are (3-actin, GAPDH, and 18S ribosomal RNA. The
software can algorithmically incorporate multiple endogenous control targets in relative
quantification calculations.

The reference sample is used as the basis for relative quantification results (or

1x sample). For example, in a study of drug effects on gene expression, an untreated
control is an appropriate reference sample.

The measurements for the target of interest are normalized to the endogenous control.

To determine the relative quantity of the target in test samples, the software compares
the normalized AC, (AC; or AC,y) for the sample to the normalized ACq (AC; or ACy) for
the reference sample.

QuantStudio™ Design and Analysis GC Software v1.0 User Guide 11
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Experiment types

Purpose

Description

Genotyping experiment

Detects single
nucleotide
polymorphism (SNP)
variants of a

target nucleic acid
sequence.

Genotyping experiments use preformulated TagMan™ SNP Genotyping Assays that include
the following components:

* Two sequence-specific primers for amplification of sequences containing the SNP of
interest

* Two allele-specific TagMan™ probes for Allele 1 and Allele 2

1. The software normalizes the fluorescence of the reporter dyes to the fluorescence of
the passive reference dye in each well.

The software plots the normalized reporter dye signal of each sample well on an Allelic
Discrimination Plot, which contrasts the reporter dye intensities of the allele-specific
probes.

The software algorithmically clusters the sample data, and assigns a genotype call to
the samples of each cluster according to its position on the plot.

Presence/absence experiment

Determines the
presence or absence
of a target nucleic
acid sequence in a
sample.

The software calls the target present or absent based on an algorithmically determined call

threshold. (The call threshold is different from the C; threshold; the C; threshold is not used
to make calls.)

Melt curve experiment

Determines the
melting temperature
(Tm) of

the ampilification
products of a

PCR that used
intercalating dyes.

In the software, melt curve analysis is included in the default run method for any experiment
type that uses intercalating dyes.

1. The software plots a melt curve based on the fluorescence of the dye with respect to
change in temperature.

2. Using the melt curve, the software calculates the melting temperature (T ;).

12
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Workflow overview

Workflow overview

Use the tabs across the top of the screen to navigate the workflow in the QuantStudio™ desktop
software.

Properties Method Plate Run Results Export

Create a template (EDT file)

v
Set up template parameters (properties, method, plate and well details)

v

Configure analysis settings
v

Run the EDT file on the instrument

v

Review run results (EDS file)

QuantStudio™ Design and Analysis GC Software v1.0 User Guide
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General

procedures to set up and
run experiments

B Set global desktop software preferences .. ... e 14
B Workflow: Set up and run an experiment . ...... ... e 15
B Setupatemplate . ... e 15
B Prepare reacClions . ... ... e 21
B Start and MoONItOr @ rUn .. ..o e 23
B Experiment setup using libraries, external files, andtemplates ........... ... . ... . ... ... .. 25

Set global desktop software preferences

1.

2. Set preferences in each tab.

In the menu bar, select Tools » Preferences.

Tab Options Action
Defaults Decimal Places to Show Enter the number of significant figures in exported results.
Language [if available] Choose a language for the software from the dropdown menu.
Experiment Baseline Start Cycle and Enter the first and last cycles to be used to calculate the baseline
Baseline End Cycle for runs that include amplification.
Auto Analysis Select to perform auto analysis at the end of each run.
Auto Save Select to save changes at the end of each run.
Print Disable color when printing Select to disable color printing.
the Well Table
Export Use Last File Location or Use | Select where to export results.
Default Folder Click Browse, then navigate to and select a default location.
Display Date Format, Time Format, and | Select the display formats. These formats are also used in the
Format Decimal Point Format export or import of data.
3. Click Save.

14
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Workflow: Set up and run an experiment

Workflow: Set up and run an experiment

Set up a template (page 15)
Create or open a template (page 16)
Enter template properties (page 16)
Confirm or edit the run method and optical filter selection (page 18)
Assign plate and well attributes (page 19)
Save a template file (page 20)
Prepare reactions (page 21)

Start and monitor a run (page 23)

For post-run procedures, see the following sections:
* Chapter 3, “General procedures to review results”
* “Export experiments or results” on page 41

Set up a template

This section describes the general procedures to set up a template in the desktop software. For setup
information for a specific experiment type, see the following sections.

® “Set up a standard curve experiment in the software” on page 45

* “Set up a relative standard curve experiment in the software” on page 54

® “Set up a comparative Ct experiment in the software” on page 55

* “Set up a genotyping experiment in the software” on page 64

* “Set up the presence/absence experiment in the software” on page 72

* “Set up a melt curve experiment in the software” on page 79

* “Set up a custom experiment in the software” on page 87
You can also use features of the desktop software to more easily set up some or all of an experiment.
For example, you can set up an experiment using one of the following strategies.

* Use desktop software libraries to set up samples, targets or SNP assays, run methods, and
analysis settings (see “Sample, target, and SNP assay libraries” on page 98).

* Import experiment parameters from external files or templates (see “Experiment setup using
libraries, external files, and templates” on page 25).

QuantStudio™ Design and Analysis GC Software v1.0 User Guide 15
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Set up a template

Create or open a template

Create a new template or open an existing template in the ﬁ Home screen.

¢ Inthe &% New Experiment pane, perform one of the following tasks to create a new template.

To Action
Create a template Click Create New Experiment.
without preexisting
settings
Create a template 1. Select Create New Experiment » Template.
from a system 2. Navigate to and select the desired file, then click Open.
template

System template files are installed with the software in:
<...>\Program Files (x86) \Applied

BioSystems\QuantStudio Design and Analysis GC
Software\templates,

where <...> is the drive on which the software is installed.

* Inthe & Open Existing Experiment pane, perform the following tasks to open an existing
template.

a. Click Open.

b. Navigate to and select the desired file, then click Open.

Enter template properties
1. Click the Properties tab to open and edit the experiment properties.

2. (Optional) In the Name field, modify the file name.
The Name field determines two file names:
* The initial EDT file name.

Note: After the initial EDT file save, modifying the Name field does not update the EDT file
name. To change the EDT file name after the initial save, select U; Save » Save As.

* The default file name for the EDS file created during an instrument run.
3. (Optional) Click the Barcode field, then scan or enter a plate barcode.
4. (Optional) Enter information in the User name and the Comments fields, if applicable.

5. Select an Instrument type, Block type, Experiment type, Chemistry (reagents), and Run Mode
(Fast or Standard cycling) from the dropdown lists.

Note: The experiment type defines the available options for the template setup. For more
information on the parameters defined in each experiment type, see “Experiment definitions” on
page 20 .

16 QuantStudio™ Design and Analysis GC Software v1.0 User Guide
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Set up a template
6. (Optional) Click Manage chemistry details (see “Enter reagent information”).
7. (Optional) Click O; Save or select U; Save » Save as.
Enter reagent information
1. In the Properties tab, click Manage chemistry details.
2. Click [+] Add.
3. Enter the reagent type, name, part number, lot number, and expiration date.

4. (Optional) Add a custom attribute for a reagent.
a. Click 4 in the table header to add a column for a custom attribute.

b. Click the Custom Attribute column header, then enter a new attribute.

0

. Select a cell in the Custom Attribute column, then enter its information.

o

. (Optional) Click X in the header to delete a custom attribute from the table.
5. (Optional) Click X to delete a reagent from the table.

6. Click Close.

Scan a barcode using the optional barcode scanner

The instrument is compatible with an optional Handheld Barcode Scanner (Cat. No. 4488442,
purchased separately). The barcode scanner reads Code 128 (alphanumeric), which supports
128 ASCII character barcodes.

1. Click the Barcode field.

2. Hold the scanner 20-30 cm away from a plate or container label and aim at the center of the
barcode, then press the trigger.

3. Slowly move the scanning beam across the barcode until the scanner emits a high-pitched tone.

When the scanner scans a barcode, it automatically transmits the following information:
¢ Transmits the alphanumeric equivalent of the barcode to the barcode field.
* Transmits other reagent information (Lot #, Part #, Expiration Date, etc.)

For more information about the hand-held barcode scanner, see the user documentation provided with
the barcode scanner.

QuantStudio™ Design and Analysis GC Software v1.0 User Guide 17
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Set up a template

Confirm or edit the run method and optical filter selection

In the Method tab, perform the follow tasks if needed.

* (Optional) Adjust the reaction volume.

* (Optional) Edit the default run method (thermal protocol).
- The default run method is optimized for TagMan ™ assays and a broad range of other reagents.

— To edit the default run method, see “Adjust method parameters” on page 92.

* (Optional) Edit the default optical filter selection (see “Select optical filters” on page 93).
— The default optical filter selection is for factory-calibrated (system) dyes.

— For more information about instrument supported dyes and their calibration and optical
filter selection, see QuantStudio™ 1 Plus Real-Time PCR Instrument Installation, Use, and
Maintenance Guide (Pub. No. 100103661).

Method elements

1] 1]
: ® |
—C)—
@]
@ Reaction volume @ Step temperature
@ Heated cover temperature @ Step hold time
@ Stage of thermal protocol @ Number of cycles
@ Step within a stage Temperature ramp rate

18 QuantStudio™ Design and Analysis GC Software v1.0 User Guide



Chapter 2 General procedures to set up and run experiments B2 18
Set up a template

Assign plate and well attributes using the Quick Setup subtab

Note: This section provides general procedures to set up the plate.

. For detailed procedures to set up a plate, see Appendix D, “Detailed procedures to set up plate / well
details and libraries”.

. For specific instructions for each experiment type, see the corresponding chapter in this guide.

1. In the Plate tab, select plate wells in the :i Plate Layout or the = Well Table. For more
information, see “Select plate wells” on page 19.

2. Click Quick Setup.

3. Assign the well attributes for the selected wells.

* Into the text fields, enter the sample and target or SNP assay names.

* From the dropdown lists, select a defined sample and target or SNP assay.

For more information about defining or importing samples and targets or SNP assays, see
“Define and assign well attributes (Advanced Setup subtab)” on page 95.

¢ Click Advanced Setup, then change the default selections for the reporter and quencher
dyes and for tasks where applicable. For more information, see “Assign a task to wells” on
page 96.

4. (Optional) Enter comments for the selected wells.
5. In the Plate Attributes pane, select a Passive Reference from the dropdown list.

Select plate wells

* Select plate wells in the i Plate Layout.

To Action
Select a single well Click a well in the plate
Select multiple wells Click-drag in the plate
Select contiguous wells Shift-click wells in the plate

Select non-contiguous wells | Ctrl-click wells in the plate

Select a column of wells Click a column header
Select all wells Click the top-left corner of the plate grid
Select a block of wells Click a well to define a corner, then Shift-click another well on the

opposite corner

Deselect a single well Ctrl-click the selected well

QuantStudio™ Design and Analysis GC Software v1.0 User Guide 19
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Set up a template

* Select plate wells in the = Well Table.

To Action
Select a single well Click a row in the table
Select multiple wells Click-drag in the table
Select contiguous wells Shift-click rows in the table
Select non-contiguous wells Ctrl-click rows in the table
Deselect a single well Ctrl-click the selected row

Experiment definitions

The parameters that you can define vary by experiment type.

. . Reference
leloh L] Passive and

Experiment Type Targets SNP Assays Samples A Reference | Endogenous

Groups

Controls

Standard Curve v — v v v -
Relative Standard v — v v v v
Curve
Comparative Cq v — v v v v
Melt Curve v - v - v -
Genotyping — v v — v —
Presence / v — v — v -
Absence
Custom v — v v v —

Save a template file

Save a template file as an unlocked template

Note: You cannot save a locked template as an unlocked template.

* Save the template with the same EDT file name.

* Inany tab, click U; Save.
* |n the menu bar, select File » Save.

* Save the template with a new EDT file name.

Note: You cannot save a locked template with a new file name.

* In any tab, select U; Save » Save as.

* |n the menu bar, select File » Save As.
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Prepare reactions

Save a template file as a locked template

IMPORTANT! Always save a backup unlocked version of a template before saving it as a locked
template.

1. In the menu bar, select File » Save As a Locked Template.

2. Enter and confirm a password, then click OK to continue saving the file.

Note: The password is required to open the template with unlimited editing options. Without the
password, a locked template can still be opened but with limited editing options.

Note: Record the password because lost passwords cannot be recovered.

Prepare reactions

See instrument user guide for information about compatible reagents and required materials for PCR
reactions.

Follow the instructions provided by the manufacturer to prepare reactions.

Follow the other guidelines described in this section.

Good laboratory practices for PCR and RT-PCR

* Wear clean gloves and a clean lab coat.

— Do not wear the same gloves and lab coat that you have previously used when handling
amplified products or preparing samples.

* Change gloves if you suspect that they are contaminated.

* Maintain separate areas and dedicated equipment and supplies for:
— Sample preparation and reaction setup.

- Amplification and analysis of products.
* Do not bring amplified products into the reaction setup area.
* Open and close all sample tubes carefully. Avoid splashing or spraying samples.
* Keep reactions and components capped as much as possible.
* Use a positive-displacement pipettor or aerosol-resistant barrier pipette tips.

® (Clean lab benches and equipment periodically with 10% bleach solution or DNA decontamination
solution.
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Prepare reactions

oGl

Guidelines for handling samples and reagents

Use calibrated pipettors and aerosol-resistant tips.

Prepare the reaction mixes according to the recommendations that are provided by the
manufacturer of the master mixes and assay mixes.

Include excess volume in calculations to account for the loss that occurs during reagent transfers.
Use TE buffer or water to dilute samples and standards.

Use care when diluting samples and standards. Mistakes or inaccuracies in making the dilutions
affect data accuracy.

Keep the dilutions and assay mix frozen and protected from light until use. Excessive exposure to
light can affect the fluorescent probes or dyes.

Perform the following tasks before each use:
— Mix the master mix thoroughly by swirling the bottle.

— Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

— Thaw any frozen samples by placing them on ice. When thawed, resuspend the samples by
vortexing, then centrifuge the tubes briefly.

Guidelines for setting up the reactions in the plates or tubes

22

Use good laboratory practices for PCR and RT-PCR. For more information, see “Good laboratory
practices for PCR and RT-PCR” on page 21.

Ensure that the arrangement of the PCR reactions matches the plate layout displayed in the
software.

Confirm that the liquid in each well is at the bottom of the well and free of bubbles. If it is not,
centrifuge the plate again.

Ensure that plates or tubes are properly sealed.

Keep the reaction plate or tubes at 4°C and protected from light until you are ready to load the
plate into the instrument.

Keep the bottom of the plate clean. Fluids and other contaminants on the bottom of the plate can
contaminate the sample block and cause an abnormally high background signal.

If necessary, use a permanent marker or pen to mark a tube and the side of a plate. Do not use
fluorescent markers.
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Start and monitor a run

Start and monitor a run

IMPORTANT! Before loading a reaction-filled plate into the instrument, review the detailed procedures
(see “Load and unload a plate in the QuantStudio™ 1 Plus Real-Time PCR Instrument” on page 84).

1. Go to an instrument connected to the computer that is running the desktop software.

2. Load the plate into the instrument.

CAUTION! The instrument should be used by trained operators who have been warned of the
moving parts hazard.

3. Open a template (EDT file) in the desktop software.

4. (Optional) In the Export tab, select Auto Export to export run results automatically after the run
ends.

5. In the Method tab and the Plate tab, review the template parameters and setup.
6. In the Run tab, select the instrument to use from the START RUN dropdown list.

7. Accept or edit the default name for the EDS file, then click Save.

Note: EDS files contain the run data and results. The system creates the EDS default file name for
the EDS file from the Experiment Name in the Properties tab.

8. During the instrument run, monitor the run:

* |n the Run tab of the desktop software.
* |n the instrument touchscreen.

9. Unload the plate from the instrument.

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the plate temperature
can reach 100°C. Allow it to cool to room temperature before handling.

Note: If the instrument does not eject the plate, contact Support.

Note: If the connection between the instrument and the desktop software is interrupted during the run,
the instrument still completes the run. However, the run data (EDS file) must be transferred from the
instrument to the desktop software using a USB drive or a network drive.
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Start and monitor a run

View real-time run information in the desktop software

¢ In the Run tab, view the time remaining for the run and the run status.

* In the Run tab, in the Amplification Plot subtab, view real-time data and plots.

* C(Click ® View to select the data that are displayed in each well.
* Select wells in the plate layout to highlight respective curves in the plot.
® Select curves in the plot to highlight respective wells in the plate layout.

Note: For melt curve experiments, you can only monitor the melt curve plot.

View real-time run information on the instrument touchscreen

You can view real-time run information in the instrument home screen.

¢ In the instrument home screen, view the block temperature, the time remaining for the run, and the
run status.

* Touch » or swipe left once to view real-time run method information.
* Touch > or swipe left twice to view real-time data and plots.
View real-time data and plots on the instrument touchscreen
1. In the instrument home screen, during an instrument run, touch > or swipe left twice.
2. Touch Well details.
3. Touch Samples, Targets, or Tasks to select a graphical representation of each selection.

4. Touch Close to return to the home screen.

Adjust the display of real-time plots on the instrument touchscreen

1. In the instrument home screen, during an instrument run, touch > or swipe left twice to view
real-time data and plots.

2. Touch Zoom.
3. Touch @ or @ to zoom in or out.
4. Touch the arrows to pan left, right, up, or down on the graph.

5. Touch Close to return to the default view.
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Experiment setup using libraries, external files, and templates

View the Post-Run Summary in the desktop software

You can view a summary of the run after the run ends.

In the Run tab, click the Post-Run Summary tab to view a summary of the run, including the following
information:

e Experiment Name

¢ User Name

¢ Errors Encountered

¢ Instrument Serial Number and Instrument Name
e Start Time, Stop Time, and Run Duration

Experiment setup using libraries, external files, and
templates

The desktop software offers the following features so that you can more easily set up some or all of an
experiment using libraries, external files, and templates.

* Use desktop software libraries to set up samples, targets or SNP assays, run methods, and
analysis settings (see “Libraries overview” on page 98).

* Import some or all of an experiment setup from external files or templates (see the following table).

Table 1 Experiment setup from external files or templates

Option Action Setup information
Import sample information Import a sample definition file — Sample name
(define samples). (see “Assign samples using - (Optional) Custom sample properties
a sample definition file” on
page 88).
Import samples, targets, and Import a plate setup file (see Plate setup information:
well assignments. “Assign samples and targets —  Well number
using plate setup files” on _  Sample name
page 89).
— Sample color
— Target name
- Dyes
— (Optional) Other well information
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Experiment setup using libraries, external files, and templates

Table 1 Experiment setup from external files or templates (continued)

Option Action Setup information
Set up the plate layout in a Copy-paste from an XLS file Plate setup information:
spreadsheet without saving to a | (see “Assign targets, samples, —  Well number
special format. and biological replicate groups S
— Sample name
or from an XLS file” on page 90). P

) - Biological Group
Use a subset of the columns in

a plate layout spreadsheet. - Target name

- Task

— Dyes

— Quantity

— Comments

— (Optional) Other well information

Use a complete template setup | Create a new template from an — Plate setup information, as above
from an existing EDT or EDS existing template or run results - Reagent information
file. file (see “Create new EDT files h | tocol

using existing EDT and EDS ermat protoco

files” on page 91). — Analysis settings
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This section includes information about reviewing results and configuring analysis settings for all
experiment types. For information about a specific experiment type, see the corresponding chapter
in this guide.

For step-by-step instructions for results review procedures, see the desktop software Help.

About the quantification cycle (C)

Term Name Description
Cq Quantification | C is the general form for gene expression metrics. G, values (both C; and Cyy) are
cycle used as the primary input values for sample quantification experiments: absolute

quantification (AQ) and relative quantification (RQ).

Ci and C,; are the algorithm-specific calculations of Cg.

Ci Threshold cycle | The PCR cycle number at which the fluorescence signal meets the threshold in the
amplification plot.

C; is the gene expression metric result when using the Baseline Threshold Algorithm.

Cn Relative The PCR cycle number for the threshold calculated from the modeled amplification
threshold cycle | efficiency profile.

Cy is the gene expression metric result when using the Relative Threshold Algorithm.
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1 Overview of the Results tab

Overview of the Results tab

Review and analyze run data in the Results tab. In the Results tab, two additional tools display at the
right of the workflow bar.

Properties Method Plate Run Results Export .

¢ Click Analyze after omitting wells or changing the analysis settings.

* (Click £# to access analysis settings.

Note: The analysis settings and plots that are available vary by experiment type.

2

@—a Q W = § R ® Amplification Plot v >_©

Amplification Plot

0.451496
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(40— ma me mc WD WE HF WG HH

Figure 1 Plot pane

(D Plot toolbar (3) Expand/contract the plot pane display
@ Plot selection list (varies by experiment) @ Plot legend

The Plot toolbar includes the following options:

® Zoom in and out * Configure plot properties
® Print or copy plot image * Show/hide plot legend
® Save plot as image file * Configure plot settings
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Overview of the Results tab |

D5 @ Vi C? alalol #=0)

1 2 3 4 5 -] 7 g 9 10 11 12
wells: [Mo Elso s 8 Empty

Figure 2 Plate Layout

@ Expand/contract the Plate Layout display (layout is expanded in this figure)
(2 View: Select well properties to display
@ Plate Layout toolbar

The Plate Layout toolbar includes the following options:

® Zoom in and out * Display Plate Layout
* Fit plate to window * Display Well Table
@—: ®© View v Groupby v C;l |\:;| §—®
# Well Sample Na... Flag Target Na... Task Dyes Cr
1 Al NTC KazZ NTC FAM-NF.. Undeter.
2 A2
3 A3 | 1 KaZ STAND.. FAM-NF.. 38.028
A aa ara [ Y AT O AR rARA RIE An nCe
Figure 3 Well Table
@ Expand/contract the Well Table display (table is @ Group by: Select a parameter by which to group well
expanded in this figure) rows
@ View: Select well properties to display @ Well Table toolbar
The Well Table toolbar includes the following options:
* Expand grouped rows * Display Plate Layout
* Collapse grouped rows * Display Well Table
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Workflow: General procedures to review the run results

Workflow: General procedures to review the run results

When a run is complete, the desktop software automatically analyzes the run data using the analysis
settings that are specified during template development. The software then displays the run results in

the Results tab.

View the Amplification Plot to confirm or correct
threshold and baseline settings (page 31)

v

Assess the experiment plot for the experiment
(for example, view the Allelic Discrimination Plot for genotyping experiments)

(see the corresponding chapter in this guide)
v
Review data for outliers and (optional) omit wells (page 34)
v
(Optional) View the Multicomponent Plot to review the dye signal profile (page 37)
v
(Optional) View the Raw Data Plot to review the signal profile (page 38)
v
(Optional) Review flags in the QC Summary (page 39)
v

(Optional) Configure the analysis settings (page 103)

IMPORTANT! If you omit wells or configure the analysis settings, click Analyze to reanalyze the data.

Guidelines for viewing and analyzing results

* For information about adjusting the views in the Results tab, see the desktop software Help.

* To reanalyze the data, select all the wells in the i Plate Layout, then click Analyze.

* To enable auto-analysis of data after a run, select Tools » Preferences » Experiment, then select
Auto Analysis.
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Assess results in the Amplification Plot

Assess results in the Amplification Plot

Amplification Plot overview

The Amplification Plot displays sample amplification as a function of cycle number or well. You can use
the amplification plot to perform the following tasks:

* Confirm or correct baseline and threshold values.
¢ |dentify outliers.

* |dentify and examine abnormal amplification. Abnormal amplification can exhibit one of the
following characteristics:

— Increased fluorescence in negative control wells.

— Absence of detectable fluorescence at an expected cycle.

Note: If you notice abnormal amplification or a complete absence of fluorescence, see the
instrument user guide for troubleshooting information.

Three plots are available. Some plots can be viewed as a linear or log1q graph.

Table 2 Amplification Plot types

Plot type Description Use to
ARn vs Cycle ARn is the magnitude of normalized * lIdentify and examine irregular
fluorescence signal, relative to the baseline amplification.
fluorescence, generated by the reporter at e View threshold values for the run.

each cycle during the PCR amplification.

Rn vs Cycle Rn is the fluorescence signal from the * Identify and examine irregular
reporter dye normalized to the fluorescence amplification.
signal from the passive reference. * View baseline values for the run.
C; vs Well C is the PCR cycle number at which the * Locate outlying amplification
fluorescence meets the threshold in the (outliers).

amplification plot.

Assess the overall shape of the Amplification Plot curves
You can assess the overall shape of the Amplification Plot curves in the Results tab.
If no data are displayed in the Results tab, click Analyze.

1. In the Results tab, select Amplification Plot from the dropdown list.

2. Click ® to configure the plot, then make the following selections:

* Plot Type: ARn vs Cycle
* Graph Type: Log
* Plot Color: Target, Sample, or Well

The Amplification Plot is displayed for the selected wells in the i Plate Layout.
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Assess results in the Amplification Plot

0.451496

0.1

ARN

0.01

- ' |
1 e S - N 'i\ 5
O 0.001 - W |
|

0.0001
] i 0 i2 14 16 18

Figure 4 Typical Amplification Plot

A typical amplification curve has four distinct sections:
(® Linear phase

(D Baseline
@ Exponential (geometric) phase @ Plateau phase

Confirm or correct threshold settings

1. In the Results tab, select Amplification Plot from the dropdown list.

2. Click ® to configure the plot, then make the following selections:

* Plot Type: ARn vs Cycle

* Graph Type: Log

* Plot Color: Target, Sample, or Well
The Amplification Plot is displayed for the selected wells in the i Plate Layout.

3. (Optional) Adjust the threshold.
Click-drag the threshold bar into the exponential phase of the curve.

[ )
Configure the C; analysis settings (see “Ct settings overview” on page 104).

Table 3 Examples of threshold settings
Set the threshold in the exponential phase of the amplification curve. A threshold set above or below the optimum can

increase the standard deviation of the replicate groups.
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Threshold setting evaluation Example

1
0.451496

o1

LRn

Threshold set correctly. oot

0.001

0.0001

01
0.032014

Threshold set too low. oot

AR

0.001

0.0001

2.712254

01

ARN

Threshold set too high. oot

0001

0.0001

Confirm or correct baseline settings
1. In the Results tab, select Amplification Plot from the dropdown list.

2. Click ® to configure the plot, then make the following selections:

* Plot Type: Rn vs Cycle

* Graph Type: Linear

¢ Plot Color: Well

* Select Show: Baseline Start / Baseline End

Note: The start and end cycles are used to calculate the baseline.

The Amplification Plot is displayed for the selected wells in the i Plate Layout.
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21 Assess results in the Amplification Plot
The start (M) and end (M) cycles display for each well.

3. (Optional) Adjust the start and end cycle values for the baseline (see “Ct settings overview” on
page 104).

-
o

Rn
= M W B h @ = 0 W

=]

Figure 5 Example of correct baseline

Set the end cycle (M) a few cycles before the cycle number where significant fluorescence signal is detected.

Omit outliers from analysis

Outlier wells have C (C; or Cyy) values that differ significantly from the average for the associated
replicate wells. To ensure Cq (C; or Cy) precision, consider omitting the outliers from analysis.

1. In the Results tab, select Amplification Plot from the dropdown list.

2. Click ®@, then make the following selections to configure the plot:

* Plot Type: C; vs Well
* Graph Type: Linear
* Plot Color: Well

The C; values are displayed for the selected wells in the :i Plate Layout.

3. Click = to examine the Well Table for outliers.
a. Select Group by » Replicate.

b. Identify outliers in each replicate group.
Outlier wells typically have one or more QC flags.

4. Omit outliers in either the = Well Table or i Plate Layout view.

* |nthe = Well Table, select Omit in outlier rows of the table.

* Inthe i Plate Layout, right-click a well, then select Omit.

5. Click Analyze to reanalyze the run data with any outliers removed.
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Optimize display of negative controls in the Amplification Plot
1. In the Results tab, select Amplification Plot from the dropdown list.

2. Click ® to configure the plot, then make the following selections:

* Plot Type: ARn vs Cycle

* Graph Type: Linear

* Plot Color: Target

* Deselect Show: Threshold

* Deselect Show: Baseline Start / Baseline End

3. In either the i Plate Layout or = Well Table, select the negative control wells (wells that should
not have amplification for a particular target).

4. Click i (configure plot properties), then select the Y Axis tab.
a. Deselect Auto-adjust range.

b. Enter Minimum value of -1.
c. Enter Maximum value of 2.

d. Click Save.

2.00 1
1.75 A
1.50 |
1.25 |
1.00 |
0.75 1
0.50 1
0.25 |
0.00
-0.25
-0.50 A
-0.75
-1.00

ARRN

Cycle

Figure 6 Example Amplification Plot of negative controls

The linear plot displays the Amplification Plot for negative controls as smooth lines. The expanded Y axis displays low
levels of amplification.
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Assess results in the Well Table view

Well Table overview

The = Well Table displays data for each well in the reaction plate. The data that are displayed depend
on the specific experiment type and can include the following information:

* Sample name, target name, task, and dyes

* Values that are specific to particular stage of the method
For example: C; or Gy, normalized fluorescence (Rn), or melt temperature (T,,)

* Values that are specific to a particular experiment type
For example: genotype calls, presence/absence calls, or quantities

* Omitted wells
* QC flags
e Comments

Group or sort the Well Table

Some of the possible options for grouping or sorting the = Well Table are described in the following
table. Available grouping categories depend on the specific experiment type and analysis settings.

Note: You can select multiple columns when sorting, but you can only make one selection for grouping

rows.

Group category

Description

Notes

Replicatel!-23!

Grouped by replicate

Examine the C; or quantity values for each
replicate group to assess the precision of C;
values.

Flag

Grouped as flagged and unflagged
wells

A flag indicates that the software found a
potential error in the flagged well.

For more information about QC flags, see the
desktop software Help.

C,124]

Grouped by C; value

C; value < 8—There may be too much template in
the reaction.

C; value > 35—There may be a low amount of
target in the reaction; for C; values > 35, expect a
higher standard deviation.

RQP

Grouped by RQ value

RQ value < 1—There is less relative target in
the test sample as compared to the calibrator
sample.

RQ value > 1—There is more relative target in
the test sample as compared to the calibrator
sample.

36
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Review the dye signal profile using the Multicomponent Plot

(continued)
Group category Description Notes
Call45] Grouped by genotype call or —
presence/absence call
Tm1[l Grouped by T,,, value Tm1 refers to the dominant peak.

This grouping category is only applicable for the
following experiment types:

* Melt curve experiments

* Any experiment with a melt curve data collection
step (e.g., absolute standard curve)

' For standard curve experiments.

[ For relative standard curve and comparative C; (AAC;) experiments.
Bl For melt curve experiments.

¥ For genotyping experiments.

Bl For presence/absence experiments.

Review the dye signal profile using the Multicomponent
Plot

Multicomponent Plot overview

The Multicomponent Plot displays the complete spectral contribution of each dye over the duration of
the PCR run.

Use the Multicomponent Plot to obtain the following information.
¢ Confirm that the signal from the passive reference dye remains unchanged throughout the run.
* Review reporter dye signal for spikes, dips, and/or sudden changes.
¢ Confirm that no amplification occurs in the negative control wells.

View and assess the Multicomponent Plot

You can view and assess the Multicomponent Plot in the Results tab.
If no data are displayed in the Results tab, click Analyze.
1. In the Results tab, select Multicomponent Plot from the dropdown list.
2. Click ® to configure the plot, then make the following selections:
* Plot Color: Dye

The Multicomponent Plot is displayed for the selected wells in the i Plate Layout.

QuantStudio™ Design and Analysis GC Software v1.0 User Guide 37



5¥ Chapter 3 General procedures to review results
Review the signal profile using the Raw Data Plot

3. Inthe i Plate Layout, select wells one at a time, then examine the Multicomponent Plot for the
following plot characteristics.

Plot characteristic

Description

Passive reference dye

The passive reference dye fluorescence signal should remain relatively constant
throughout the PCR process.

Reporter dye

The reporter dye fluorescence signal should display a flat region corresponding to
the baseline, followed by a rapid rise in fluorescence as the amplification proceeds.

Irregularities in the signal

Spikes, dips, and/or sudden changes in the fluorescence signal may have an impact
on the data.

Negative control wells

The negative control wells should show no significant increase in fluorescence
signal.

3,000,000

2,500,000 -

2,000,000

1,500,000 -

Fluorescence

1,000,000 -

500,000 -

0

a 2

Hran [l ROX

4 & & W0 12 £ 18 W@ 2N = 24 X M 3N I ¥ ¥ 33 44 442
Cycle

Figure 7 Example Multicomponent Plot (single well)

Review the signal profile using the Raw Data Plot

Raw Data Plot overview

The Raw Data Plot displays the raw fluorescence signal (not normalized) for each optical filter during
each cycle of the real-time PCR.

View the Raw Data Plot to confirm a stable increase in signal (no abrupt changes or dips) from the

appropriate filter.

38
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Review the flags in the QC Summary

View and assess the Raw Data Plot

You can view and assess the Raw Data Plot in the Results tab.

If no data are displayed in the Results tab, click Analyze.

1. In the Results, select Raw Data Plot from the dropdown list.
The Raw Data Plot is displayed for the selected wells in the i Plate Layout.

2. Click ® to display the Show Cycle scale.

3. Click-drag the Show Cycle pointer from cycle 1 to cycle 40, and confirm that each filter displays
the characteristic signal increase.

For more information on each filter set, see the instrument user guide (see Appendix F,
“Documentation and support”).
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Figure 8 Example Raw Data Plot

Review the flags in the QC Summary

The QC Summary in the Results tab displays a list of the QC flags, including the flag frequency and
location.

If no data are displayed in the Results tab, click Analyze.

1. In the Results tab, select QC Summary from the dropdown list.

2. Review the Flag Details table and the summary.
The Wells column of the Flag Details table identifies wells that triggered a flag.

3. (Optional) In the Flag Details table, click each flag to display a brief description of the flag.
For more information about the flag, see the desktop software Help.
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View calibration results in the desktop software
Calibration results obtained on the instrument can be transferred via USB to the desktop software.
1. In the {3} Home screen, click a5 Open.
2. Navigate to and select the desired calibration EDS file.

If you are viewing calibration data files, gh Calibration QC Status is displayed to the right of the i
Plate Layout and = Well Table.

Note: For more information about using the i Plate Layout and
“General procedures to review results” .

Well Table, see Chapter 3,

Review ROI/Uniformity calibration results
1. In the ROI tab, select a Filter Set from the dropdown list to see the corresponding results.

2. In the Uniformity tab, use the i Plate Layout, = Well Table, and gt Calibration QC Status to
review the run results.

Review Background calibration results

1. Select the plate wells in the i Plate Layout or the = Well Table to view the corresponding
curves. For more information, see “Select plate wells” on page 19.

2. Review data in the = Well Table.
a. Review the results for each well in tabular format.

b. Sort the wells according to well or normalized fluorescence with each filter.
c. Select wells to review data in the analysis plot.

3. Click ¢h Calibration QC Status to review the quality of the calibration data.

Review Dye calibration results
1. Select a Dye row in the Calibration table to view the corresponding analysis data plot.

2. Select the plate wells in the i Plate Layout or the = Well Table to view the corresponding
curves. For more information, see “Select plate wells” on page 19.

3. Review data in the = Well Table.
a. Review the results for each well in tabular format.

b. Sort the wells according to well or normalized fluorescence with each filter.
c. Select wells to review data in the analysis plot.

4. Click ¢h Calibration QC Status to review the quality of the calibration data.
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Export experiments or results

Override the calibration data

Each EDS file contains the calibration data from the instrument on which it was run. You can use
calibration data from another instrument for analysis of your run data.

Calibration data must be from another QuantStudio™ 1 Plus Real-Time PCR Instrument. Calibration
data cannot be from any other type of instrument.

1. Open the EDS file to recalibrate.

2. Select Analysis » Override Calibration » Use Calibration From Another File.
3. Navigate to, then select the EDS file containing the alternative calibration data.
4. Click Open.

5. (Optional) To revert to the original calibration data, select Analysis » Override Calibration » Revert
To Original Calibration.

Export experiments or results

For step-by-step instructions for exporting experiments or results, see the desktop software Help.

Options for exporting run data and results

To Action

Save a plot as an image file Click o

Print a plot Click &

Copy a plot to the clipboard Click

Export run data and results Click Export

Print the plate layout Select File » Print

Create slides Select File » Send to PowerPoint

Print a report Select File » Print Report
Export configurations

Data type Description File format

Plate setup files, for future Plate setup information e XLS

experiments For example, the well number, sample name and color, * XLSX

target name, dyes, and other reaction plate contents. o TXT
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(continued)
Data type Description File format
Analyzed data, for further analysis QuantStudio™ format * XLS
e XLSX
« TXT

RDML (Real-Time PCR Data Markup Language) format * RDML

Used for standard curve, relative standard curve, and
comparative C; experiments.
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Standard curve experiments

Overview

Use standard curve experiments to determine absolute target quantity in samples.

In a standard curve experiment, the software performs the following tasks.

1. The software measures amplification of the target in a standard dilution series and in test samples.

The software generates a standard curve using data from the standard dilution series.

3. The software uses the standard curve to interpolate the absolute quantity of target in the test

samples.

Reaction types

Multiple targets can be assayed in a standard curve experiment, but each target requires its own
standard curve.

Table 4 Reaction types for standard curve experiments

Reaction type (task) Sample description

Standard A sample that contains known or known relative quantities of the target

* For known quantities —Quantify the target in the standard sample
using an independent method.

* For known relative quantities— Generate a relative dilution series of
the target standards.
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Standard curve experiments

Table 4 Reaction types for standard curve experiments (continued)

Reaction type (task) Sample description
Unknown Test sample
No-template control (NTC/ Water or buffer
Negative Control) No amplification of the target should occur in NTC wells.

* The precision of quantification experiments improves as the number of replicate reactions
increases. Set up the number of replicates appropriate for the experiment.

* For accurate and precise efficiency measurements, set up the standard dilution series with at least
five dilution points over a broad range of standard quantities, 4 to 6 logs (10%- to 108-fold). A
concentrated template, such as a plasmid or PCR product, is best for this purpose.

A narrow range of standard quantities may be appropriate if the amount of standard is limited, the
target is in low abundance, or the target is known to fall within a given range.

Compatible PCR options

Table 5 PCR options for standard curve experiments

Single- or multiplex PCR PCR or RT-PCRI'] Detection chemistry
Singleplex PCR TagMan™
Multiplex 1-step RT-PCR SYBR™ Green
2-step RT-PCR

[ RT-PCR: reverse transcription-PCR
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Set up a standard curve experiment in the software

Set up a standard curve experiment in the software

1. Inthe ﬁ Home screen, create or open a template.

* Inthe &% New Experiment pane, click Create New Experiment to create a new template.

* Inthe & Open Existing Experiment pane, click Open to select and open an existing
template.

2. In the Properties tab, enter the template information.

3. In the Method tab, adjust the reaction volume.
For most experiments, the default run method is appropriate.

4. In the Plate tab (Quick Setup), assign plate attributes.
a. In the Plate Attributes pane, select the Passive Reference from the dropdown list.

5. In the Plate tab (Quick Setup), define and assign well attributes.
a. Select wells in the i Plate Layout or the = Well Table.

b. Assign samples and targets to selected wells.
* Enter new sample and target names in the text fields.
* Select previously defined samples and targets from the dropdown lists.

Note: New sample or target names entered in the Quick Setup subtab are automatically
populated with default values for Reporter (FAM) and Quencher (NFQ-MGB) and assigned a
task ((I] Unknown). Edit these values in the Advanced Setup subtab.

6. (Optional) In the Plate tab, set up standard dilutions (see “Define and set up standard dilutions” on
page 97).

7. (Optional) In the Plate tab (Advanced Setup), assign tasks.
Well Table.

a. Select wells in the i Plate Layout or the

b. In the Targets table, select the checkbox of a target, then select a task from the dropdown

list.

Reaction type Task
Unknown (test sample) m
No-template control L

8. (Optional) In the Plate tab (Advanced Setup), define and assign biological replicate groups (see
“Define and assign biological replicate groups” on page 98).

In the Plate tab (Advanced Setup), ensure the Samples table contains the following sample
information:

* One sample name for each technical replicate group of an unknown sample

® (Optional) A standard sample for each target
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Set up and run the PCR reactions

Set up and run the PCR reactions

1. Assemble the PCR reactions. Follow the manufacturer's instructions for the reagents and follow
the plate layout set up in the software (see “Prepare reactions” on page 21).

2. In the desktop software, open the appropriate template (EDT file).

3. Load the reaction plate into the instrument and start the run (see “Start and monitor a run” on
page 23).

Review results

Workflow: Review standard curve experiments

View the Amplification Plot to confirm or correct
threshold and baseline settings (page 31)

v
Assess the Standard Curve Plot (page 48)
v
Review data for outliers and (optional) omit wells (page 34)
v
(Optional) View the Multicomponent Plot to review the dye signal profile (page 37)
v
(Optional) View the Raw Data Plot to review the signal profile (page 38)
v
(Optional) Review flags in the QC Summary (page 39)
v

(Optional) Configure the analysis settings (page 48, page 103)

IMPORTANT! If you omit wells or configure the analysis settings, click Analyze to reanalyze the data.
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Standard Curve Plot overview

oA
Review results

The Standard Curve Plot displays the standard curve for samples designated as standards. The
software calculates the quantity of an unknown target from the standard curve.

Table 6 Results or metrics to review in the Standard Curve Plot

Result_s or Description Criteria for evaluation
metrics
Slope and The amplification efficiency is calculated | A slope close to —3.3 indicates optimal, 100% PCR

amplification

using the slope of the regression line in

amplification efficiency.

efficiency the standard curve. Factors that affect amplification efficiency:
* Improper design of the primer and probe
* Range of standard quantities—For accurate and
precise efficiency measurements, use a broad range
of standard quantities, 5 to 6 logs (10°- to 106-fold).
* Number of standard replicates—For accurate
efficiency measurements, include replicates to
decrease the effects of pipetting inaccuracies.
¢ PCR inhibitors—PCR inhibitors and contamination
in the reaction can reduce amplification efficiency.
® Other possible factors:
— Component and properties of the reaction mix,
such as salt content, DMSO, pH, etc.
— Inaccurate sample or reagent pipetting
— Improper analysis settings
— Incorrect plate setup
R2 value The R2 value is a measure of the * Avalue of 1.00 indicates a perfect fit between the
(correlation | closeness of fit between the regression regression line and the data points.
coefficient) | line and the individual C, data points of e An R2value > 0.99 is desirable.
the standard reactions.
Error The standard error of the slope of the Acceptable value is determined by the experimental
regression line in the standard curve. criteria.
The error can be used to calculate a
confidence interval (Cl) for the slope and
therefore the ampilification efficiency.
C; values The threshold cycle (C;) is the PCR cycle | A C; value > 8 and < 35 is desirable.

number at which the fluorescence level
meets the threshold.

C; value < 8—There may be too much template in
the reaction.

C; value > 35—There may be a low amount of target
in the reaction; for C; values > 35, expect a higher
standard deviation.
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Review results

View and assess the Standard Curve Plot
You can view and assess the Standard Curve Plot in the Results tab.
If no data are displayed in the Results tab, click Analyze.

1. Select Standard Curve from the dropdown list.

2. Click ® to configure the plot, then make the following selections:

* Target: Select the target of interest
* Plot Color: Sample, Target, or Task
* Select all wells in the i Plate Layout

The Standard Curve Plot is displayed. The slope, R? value, amplification efficiency, and error are
displayed below the plot.

3. Confirm that the slope, R? value, amplification efficiency, and error meet the experimental criteria.
4. Visually check that all unknown sample Cq (G; or Cyy) values fall within the standard curve range.

5. Inthe = Well Table, use the Group By dropdown list to confirm that the Cq (C; or Cpy) values of all
replicate samples meet the experimental criteria.
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Figure 9 Example Standard Curve Plot

If the results do not meet the experimental criteria, troubleshoot using one of the following strategies:
¢ Omit wells, then reanalyze. For more information, see “Omit outliers from analysis” on page 34.

* Repeat the experiment, adjusting the template setup and analysis settings to improve results.

To learn more about the Standard Curve Plot, see “Standard Curve Plot overview” on page 47.

Standard curve settings overview

You can use the standard curve from another experiment and apply it to the current experiment. The
two experiments must be from the same instrument type, block type, and run method.

To import an external standard curve, select £# Analysis Settings » Standard Curve Settings, then
follow the instructions on the screen.

For step-by-step instructions for adjusting the standard curve settings, see the desktop software Help.
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Overview

Use relative standard curve experiments to determine relative target quantity in samples.

In a relative standard curve experiment, the software performs the following tasks.

1.

The software measures amplification of the target of interest and of an endogenous control target
in a standard dilution series, in a reference (calibrator) sample, and in test samples.

The endogenous control is a target that is expressed equally in all samples; examples

of endogenous controls are -actin, GAPDH, and 18S ribosomal RNA. The software

can algorithmically incorporate multiple endogenous control targets in relative quantification
calculations.

The reference sample is used as the basis for relative quantification results (or 1x sample). For
example, in a study of drug effects on gene expression, an untreated control is an appropriate
reference sample.

The software generates standard curves for the target of interest and the endogenous control using
data from the corresponding standard dilution series.

The software uses the standard curves to interpolate the quantities of the target of interest and the
endogenous control in each sample. The target quantity in each sample is then normalized to the
sample's endogenous control quantity.

To determine the relative quantity of the target in test samples, the software divides the normalized
target quantity in the sample by the normalized target quantity in the reference sample.

QuantStudio™ Design and Analysis GC Software v1.0 User Guide 49



= Chapter 5 Set up, run, and review relative standard curve experiments and comparative C; experiments
Relative standard curve experiments

For a comparison of this method to the comparative C; (AACy) method, see “Relative quantitation:
relative standard curve vs. comparative Ct” on page 53.
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Relative standard curve experiments
Reaction types

Relative standard curve experiments include the following reaction types for the endogenous control
target and each target of interest.

Table 7 Reaction types for relative standard curve experiments

Reaction type (task) Sample description

Standard A sample that contains known or known relative quantities of the target

* For known quantities—Quantify the target in the standard sample
using an independent method.

* For known relative quantities—Generate a relative dilution series of
the target standards.

Reference samplel'l The sample that is used as the basis for relative quantification results
Unknown Test or reference sample
No-template control (NTC/ Water or buffer

Negative Control) No amplification of the target should occur in NTC wells.

' To identify a sample as a reference sample, review the relative quantification settings.

* The precision of quantification experiments improves as the number of replicate reactions
increases. Set up the number of replicates appropriate for the experiment.

* For accurate and precise efficiency measurements, set up the standard dilution series with at least
five dilution points over a broad range of standard quantities, 4 to 6 logs (10%- to 106-fold). A
concentrated template, such as a plasmid or PCR product, is best for this purpose.

A narrow range of standard quantities may be appropriate if the amount of standard is limited, the
target is in low abundance, or the target is known to fall within a given range.

Compatible PCR options

Table 8 PCR options for relative standard curve experiments

Single- or multiplex PCR PCR or RT-PCRI! Detection chemistry
Singleplex PCR TagMan™
Multiplex 1-step RT-PCR SYBR" Green
2-step RT-PCR

' RT-PCR: reverse transcription PCR.
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Comparative Ct experiments

Comparative C; experiments

Overview

Use comparative C; (AACy) experiments to determine relative target quantity in samples.
In a comparative C; experiment, the software performs the following tasks.

1. The software measures amplification of the target of interest and of an endogenous control target
in a reference (calibrator) sample and in test samples.
The endogenous control is a target that is expressed equally in all samples; examples
of endogenous controls are B-actin, GAPDH, and 18S ribosomal RNA. The software
can algorithmically incorporate multiple endogenous control targets in relative quantification
calculations.
The reference sample is used as the basis for relative quantification results (or 1x sample). For
example, in a study of drug effects on gene expression, an untreated control is an appropriate
reference sample.

2. The measurements for the target of interest are normalized to the endogenous control.

3. To determine the relative quantity of the target in test samples, the software compares the
normalized AC, (AC; or AC,y) for the sample to the normalized AC, (AC; or ACy) for the reference
sample.

For a comparison of this method to the relative standard curve method, see “Relative quantitation:
relative standard curve vs. comparative Ct” on page 53.

Reaction types

Comparative C; experiments include the following reaction types for the endogenous control target and
each target of interest.

Table 9 Reaction types for comparative C; experiments

Reaction type (task) Sample description
Reference samplel'] The sample that is used as the basis for relative quantification results
Unknown Test or reference sample
No-template control (NTC/ Water or buffer
Negative Control) No amplification of the target should occur in NTC wells.

' To identify a sample as a reference sample, review the relative quantification settings.

The precision of quantification experiments improves as the number of replicate reactions increases.
Set up the number of replicates appropriate for the experiment.
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Relative quantitation: relative standard curve vs. comparative Ct

Compatible PCR options

Table 10 PCR options for comparative C; experiments

Single- or multiplex PCR PCR or RT-PCR!'] Detection chemistry
Singleplex PCR TagMan™
Multiplex 1-step RT-PCR SYBR" Green
2-step RT-PCR

[ RT-PCR: reverse transcription PCR

Relative quantitation: relative standard curve vs.
comparative C;

Use either relative standard curve experiments or comparative C; experiments to determine the relative
quantity of a target of interest in a test sample relative to a reference sample. Relative quantitation
experiments are commonly used for the following applications.

* Comparison of expression levels of a gene in different tissues.

* Comparison of expression levels of a gene in a treated sample vs. an untreated sample.

* Comparison of expression levels of a gene of interest in different genetic backgrounds.

* Analysis of the gene expression changes over time under specific treatment conditions.

Table 11 Comparison of relative standard curve experiments and comparative C; experiments

Characteristic Relative standard curve Comparative C;

Typical use Best for assays that have suboptimal PCR Best for high-throughput measurements of
efficiency. relative gene expression of many genes in

many samples.

Advantage Requires the least amount of validation * Relative levels of target in samples can be
because the PCR efficiencies of the target determined without the use of a standard
and endogenous control do not need to be curve, if the PCR efficiencies of the target
equivalent. and endogenous control are relatively

equivalent.
* Reduced reagent usage.
* More space available in the reaction plate.

Limitation A standard curve must be constructed for each | ® Suboptimal (low PCR efficiency) assays
target, which requires more reagents and more may produce inaccurate results.
space in the reaction plate. ¢ Before you use the comparative C;

method, we recommend that you
determine that the PCR efficiencies for the
target assay and the endogenous control
assay are approximately equal.
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Set up a relative standard curve experiment in the software

Set up a relative standard curve experiment in the software

1. Inthe ﬁ Home screen, create or open a template.

* Inthe &% New Experiment pane, click Create New Experiment to create a new template.

* Inthe & Open Existing Experiment pane, click Open to select and open an existing
template.

2. In the Properties tab, enter the template information.

3. In the Method tab, adjust the reaction volume.
For most experiments, the default run method is appropriate.

4. In the Plate tab (Quick Setup), assign plate attributes.

a. In the Plate Attributes pane, select a Passive Reference, Reference Sample, and
Endogenous Control from the dropdown lists.

5. In the Plate tab (Quick Setup), define and assign well attributes.
a. Select wells in the i Plate Layout or the = Well Table.

b. Assign samples and targets to selected wells.
* Enter new sample and target names in the text fields.
* Select previously defined samples and targets from the dropdown lists.

Note: New sample or target names entered in the Quick Setup subtab are automatically
populated with default values for Reporter (FAM) and Quencher (NFQ-MGB) and assigned a
task ([I] Unknown). Edit these values in the Advanced Setup subtab.

6. In the Plate tab, set up standard dilutions (see “Define and set up standard dilutions” on
page 97).

7. (Optional) In the Plate tab (Advanced Setup), assign tasks.
Well Table.

a. Select wells in the i Plate Layout or the

b. In the Targets table, select the checkbox of a target, then select a task from the dropdown

list.

Reaction type Task
Unknown (test sample) m
No-template control N

8. (Optional) In the Plate tab (Advanced Setup), define and assign biological replicate groups (see
“Define and assign biological replicate groups” on page 98).

The targets of interest and the endogenous control target should each have wells that are assigned with
standard dilutions, unknown, and no-template-control tasks, and corresponding samples.
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K
Set up a comparative Ct experiment in the software

In the Plate tab (Advanced Setup), ensure the Samples table contains the following samples.
* Unknown samples
* Reference sample

* (Optional) For a dilution of target standards, each dilution step for each endogenous control target
and target of interest has its own sample name.

Set up a comparative C; experiment in the software

1. Inthe ﬁ Home screen, create or open a template.

* Inthe a% New Experiment pane, click Create New Experiment to create a new template.

* Inthe & Open Existing Experiment pane, click Open to select and open an existing
template.

2. In the Properties tab, enter the template information.

3. In the Method tab, adjust the reaction volume.
For most experiments, the default run method is appropriate.

4. In the Plate tab (Quick Setup), assign plate attributes.

a. In the Plate Attributes pane, select a Passive Reference, Reference Sample, and
Endogenous Control from the dropdown lists.

5. In the Plate tab (Quick Setup), define and assign well attributes.
Well Table.

a. Select wells in the i Plate Layout or the

b. Assign samples and targets to selected wells.
* Enter new sample and target names in the text fields.
* Select previously defined samples and targets from the dropdown lists.

Note: New sample or target names entered in the Quick Setup subtab are automatically
populated with default values for Reporter (FAM) and Quencher (NFQ-MGB) and assigned a
task ((I] Unknown). Edit these values in the Advanced Setup subtab.

6. (Optional) In the Plate tab (Advanced Setup), assign tasks.
a. Select wells in the i Plate Layout or the = Well Table.

b. In the Targets table, select the checkbox of a target, then select a task from the dropdown

list.

Reaction type Task
Unknown (test sample) m
No-template control D

7. (Optional) In the Plate tab (Advanced Setup), define and assign biological replicate groups (see
“Define and assign biological replicate groups” on page 98).
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Set up and run the PCR reactions

The targets of interest and the endogenous control target should each have wells assigned with
unknown and no-template-control tasks, and corresponding samples.

In the Plate tab (Advanced Setup), ensure the Samples table contains:
* Unknown samples

* Reference sample

Set up and run the PCR reactions

56

1. Assemble the PCR reactions. Follow the manufacturer's instructions for the reagents and follow
the plate layout set up in the software (see “Prepare reactions” on page 21).

2. In the desktop software, open the appropriate template (EDT file).

3.

Load the reaction plate into the instrument and start the run (see “Start and monitor a run” on
page 23).
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Review results

Workflow: Review relative standard curve and comparative C; experiments

Relative standard curve experiments Comparative C; experiments

View the Amplification Plot to confirm or correct
threshold and baseline settings (page 31)

v v

Assess the Standard Curve Plot (page 48) —

v v

Review data for outliers and (optional) omit wells (page 34)
v
Assess the Gene Expression Plot (page 60)
v
(Optional) View the Endogenous Control Profile using the QC Plot (page 61)
v
(Optional) View the Multicomponent Plot to review the dye signal profile (page 37)
v
(Optional) View the Raw Data Plot to review the signal profile (page 38)

v

(Optional) Review flags in the QC Summary (page 39)
v

(Optional) Configure the analysis settings (page 62, page 103)

IMPORTANT! If you omit wells or configure the analysis settings, click Analyze to reanalyze the data.
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Review results

o
I

View and assess the Standard Curve Plot

This section only applies to relative standard curve experiments.

Standard Curve Plot overview

The Standard Curve Plot displays the standard curve for samples designated as standards. The
software calculates the quantity of an unknown target from the standard curve.

Table 12 Results or metrics to review in the Standard Curve Plot

Result_s or Description Criteria for evaluation
metrics
Slope and The amplification efficiency is calculated | A slope close to —3.3 indicates optimal, 100% PCR
amplification | using the slope of the regression line in amplification efficiency.
efficiency the standard curve. Factors that affect amplification efficiency:
* Improper design of the primer and probe
* Range of standard quantities—For accurate and
precise efficiency measurements, use a broad range
of standard quantities, 5 to 6 logs (10°- to 106-fold).
* Number of standard replicates—For accurate
efficiency measurements, include replicates to
decrease the effects of pipetting inaccuracies.
* PCR inhibitors—PCR inhibitors and contamination
in the reaction can reduce amplification efficiency.
® Other possible factors:
— Component and properties of the reaction mix,
such as salt content, DMSO, pH, etc.
— Inaccurate sample or reagent pipetting
— Improper analysis settings
— Incorrect plate setup
R2 value The R2 value is a measure of the * A value of 1.00 indicates a perfect fit between the
(correlation | closeness of fit between the regression regression line and the data points.
coefficient) |line and the individual C data points of e An R2 value > 0.99 is desirable.
the standard reactions.
Error The standard error of the slope of the Acceptable value is determined by the experimental
regression line in the standard curve. criteria.
The error can be used to calculate a
confidence interval (Cl) for the slope and
therefore the ampilification efficiency.
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Review results
Table 12 Results or metrics to review in the Standard Curve Plot (continued)
Result.s or Description Criteria for evaluation
metrics

C; values The threshold cycle (Cy) is the PCR cycle | A C; value > 8 and < 35 is desirable.
number at which the fluorescence level .

C; value < 8—There may be too much template in
meets the threshold.

the reaction.

* C; value > 35—There may be a low amount of target
in the reaction; for C; values > 35, expect a higher
standard deviation.

View and assess the Standard Curve Plot
You can view and assess the Standard Curve Plot in the Results tab.

If no data are displayed in the Results tab, click Analyze.

1. Select Standard Curve from the dropdown list.

2. Click ® to configure the plot, then make the following selections:

* Target: Select the target of interest
* Plot Color: Sample, Target, or Task
* Select all wells in the i Plate Layout

The Standard Curve Plot is displayed. The slope, R? value, amplification efficiency, and error are
displayed below the plot.

3. Confirm that the slope, R? value, amplification efficiency, and error meet the experimental criteria.
4. Visually check that all unknown sample Cq (C; or Cy) values fall within the standard curve range.

5. Inthe = Well Table, use the Group By dropdown list to confirm that the Cq (Cy or Cyy) values of all
replicate samples meet the experimental criteria.
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Figure 10 Example Standard Curve Plot
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If the results do not meet the experimental criteria, troubleshoot using one of the following strategies:
¢ Omit wells, then reanalyze. For more information, see “Omit outliers from analysis” on page 34.

* Repeat the experiment, adjusting the template setup and analysis settings to improve results.

To learn more about the Standard Curve Plot, see “Standard Curve Plot overview” on page 47.

Standard curve settings overview

You can use the standard curve from another experiment and apply it to the current experiment. The
two experiments must be from the same instrument type, block type, and run method.

To import an external standard curve, select £ Analysis Settings » Standard Curve Settings, then
follow the instructions on the screen.

For step-by-step instructions for adjusting the standard curve settings, see the desktop software Help.

Gene Expression Plot overview

The Gene Expression Plot displays the results of relative quantification calculations for relative standard
curve and comparative C; experiments.

Review the Gene Expression Plot to evaluate the fold change in expression level of the targets of
interest in the test samples relative to the reference sample.

There are two plots available, depending on the experimental focus. Each plot can be viewed on a
linear, log4g, Ln, and log, scale.

Table 13 Gene Expression plots

Plot type Description

RQ vs. Target Groups the relative quantification (RQ) values by target. Each sample is
plotted for each target.

RQ vs. Sample Groups the relative quantification (RQ) values by sample. Each target is
plotted for each sample.
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Figure 11 Example Gene Expression Plot

In this example, there is one target of interest, and the reference sample (calibrator) is sample 800.
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QC Plot overview

The QC Plot is a visual display of the Cq (C; or Cy) levels of potential endogenous control targets across
all samples (Endogenous Control Profile).

Use the QC Plot to help choose the best endogenous control for an experiment. Select the target with a
quantity (indicated by Cq (C; or Cy) value) that does not change under experimental conditions.

All targets can be displayed in the QC Plot. You can view up to four potential endogenous controls at a
time.

View and assess the QC Plot

You can view and assess the QC Plot in the Results tab.

If no data are displayed, click Analyze.

1. In the Results tab, select QC Plot from the dropdown list.
The Endogenous Control Profile is displayed.

2. In the right pane, select the targets to display, then select the color and shape from the dropdown
lists.

3. (Optional) In the View Replicate Results Table tab, select the samples to omit from analysis.

4. (Optional) To change the endogenous controls used for analysis, select £ Analysis
Settings » Relative Quantification Settings (see “Relative quantification settings overview” on
page 62).

5. Click Analyze to see the result of the adjustments.

30 ™ = = u
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Figure 12 Example QC Plot
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Relative quantification settings overview

In the Results tab, select ¢ Analysis Settings » Relative Quantification Settings to configure the

following parameters:

Parameter

Description

Analysis Type

Select Multiplex or Singleplex analysis.

References

Set the reference sample, or set a biological replicate group as the
reference sample.

Endogenous Controls

Change the endogenous control, or select multiple endogenous
controls.

Efficiency

(Comparative C; experiments only)

Set the amplification efficiency for a target.

The amplification efficiency for each target is calculated from the
standard dilution series in relative standard curve experiments.

Outlier Rejection

(Multiplex reactions only)

Outliers with AC, (AC; or AC) values less than or equal to the entered
value are rejected.

RQ Min/Max Calculations

Determines the algorithm used to calculate the relative quantification
minimum and maximum values (error bars).

* Confidence Level—Select to calculate the RQ minimum and
maximum values based on the selected confidence level.

¢ Standard Deviations—Select to calculate the RQ minimum and
maximum values based on the selected number of standard
deviations.

For step-by-step instructions for adjusting the relative quantification settings, see the desktop software

Help.
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Genotyping experiments

Overview

Use genotyping experiments to detect single nucleotide polymorphism (SNP) variants of a target
nucleic acid sequence.

Genotyping experiments use preformulated TagMan™ SNP Genotyping Assays that include the
following components:

Two sequence-specific primers for amplification of sequences containing the SNP of interest
Two allele-specific TagMan™ probes for Allele 1 and Allele 2

In a genotyping experiment, the software performs the following tasks.

1.

The software normalizes the fluorescence of the reporter dyes to the fluorescence of the passive
reference dye in each well.

The software plots the normalized reporter dye signal of each sample well on an Allelic
Discrimination Plot, which contrasts the reporter dye intensities of the allele-specific probes.

The software algorithmically clusters the sample data, and assigns a genotype call to the samples
of each cluster according to its position on the plot.

QuantStudio™ Design and Analysis GC Software v1.0 User Guide 63



2% Chapter 6 Set up, run, and review genotyping experiments
Set up a genotyping experiment in the software

Reaction types

Table 14 Reaction types for genotyping experiments

Reaction type (task) Sample description
Unknown Test sample
No-template control Water or buffer

No amplification of the target should occur in NTC wells.

Allele control (1/1) Control sample that is homozygous for allele 1
Allele control (1/2) Control sample that is heterozygous allele 1/allele 2
Allele control (2/2) Control sample that is homozygous for allele 2

Allele controls are optional but recommended. Including allele controls helps to improve the clustering
algorithm, particularly in situations where a limited number of samples are run.

In genotyping experiments, the software makes calls for individual wells. Running 3 or more replicates
of each reaction can help identify outlier wells that may be present.

Compatible PCR options

Table 15 PCR options for genotyping experiments

Single- or multiplex PCR PCR or RT-PCRI' Detection chemistry

Multiplex!?] PCR TagMan™

[ RT-PCR: reverse transcription PCR
[l Each SNP genotyping assay is a multiplex assay with a probe for each allele. Multiple SNP assays can be performed in a single well.

Genotyping calls are based either on end-point data (data collected outside of any PCR cycling stage)
or on real-time data (data collected during a PCR cycling stage). For detailed information, see the
analysis settings section of this guide.

We recommend collecting real-time amplification data during the PCR stage, for troubleshooting
purposes.

Set up a genotyping experiment in the software

1. Inthe ﬁ Home screen, create or open a template.

* Inthe &% New Experiment pane, click Create New Experiment to create a new template.

* Inthe &% Open Existing Experiment pane, click Open to select and open an existing
template.

2. In the Properties tab, enter the template information.
3. In the Method tab, adjust the reaction volume.

For most experiments, the default run method is appropriate.
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Set up a genotyping experiment in the software

4. In the Plate tab (Quick Setup), assign plate attributes.
a. In the Plate Attributes pane, select the Passive Reference from the dropdown list.

5. In the Plate tab (Quick Setup), define and assign well attributes.

a. Select wells in the i Plate Layout or the = Well Table.

b. Assign samples and SNP assays to selected wells.
* Enter new sample and SNP assay names in the text fields.
® Select previously defined samples and SNP assays from the dropdown lists.

Note: New sample or SNP assay names entered in the Quick Setup subtab are automatically
populated with the following default values:

Allele 1 Reporter Quencher Allele 2 Reporter Quencher Task
Allele 1 VIC NFQ-MGB Allele 2 FAM NFQ-MGB E
Unknown

Edit these values in the Advanced Setup subtab.

6. (Optional) In the Plate tab (Advanced Setup), assign tasks.
a. Select wells in the i Plate Layout or the = Well Table.

b. In the SNP Assays table, select the checkbox of a SNP assay, then select a task from the
dropdown list.

Reaction type Task

Unknown (test sample)

No-template control

Allele control (1/1)1]
Allele control (1/2)"]

N EE e

Allele control (2/2)[]

[ Optional but recommended

In the Plate tab (Advanced Setup), ensure the Samples table contains the following samples:
* Unknown samples

® (Optional) Allele control samples
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Set up and run the PCR reactions

1. Assemble the PCR reactions. Follow the manufacturer's instructions for the reagents and follow
the plate layout set up in the software (see “Prepare reactions” on page 21).

2. In the desktop software, open the appropriate template (EDT file).

3. Load the reaction plate into the instrument and start the run (see “Start and monitor a run” on
page 23).

Review results

Workflow: Review genotyping experiments

Assess the Allelic Discrimination Plot (page 67)
v

(Optional) View the Amplification Plot (page 31)
v

Review data for outliers and (optional) omit wells (page 34)
v
(Optional) View the Multicomponent Plot to review the dye signal profile (page 37)
v
(Optional) View the Raw Data Plot to review the signal profile (page 38)
v
(Optional) Review flags in the QC Summary (page 39)

v

(Optional) Configure the analysis settings (page 69, page 103)

IMPORTANT! If you omit wells or configure the analysis settings, click Analyze to reanalyze the data.
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Review results

Allelic Discrimination Plot overview

The Allelic Discrimination Plot contrasts the Rn or the ARn of the reporter dyes for the allele-specific
probes of the SNP assay. It is an intermediary step in the software algorithm for genotyping calls.

Data points tend to cluster along the horizontal axis (Allele 1), vertical axis (Allele 2), or diagonal
(Allele 1/Allele 2).

Table 16 Data clusters in the Allelic Discrimination Plot

A substantial increase in... Clusters along... Indicates...
Fluorescence of VIC™ dye-labeled probe Horizontal axis Homozygosity for Allele 1
only
Fluorescence of FAM™ dye-labeled probe Vertical axis Homozygosity for Allele 2
only
Fluorescence of both VIC™ and FAM™ dye- Diagonal Heterozygosity for Allele 1 —Allele
labeled probes 2

Review the allelic discrimination plot to assess data clusters.
¢ Confirm that clustering of control samples is as expected.
* Visually assess clusters for the three possible genotypes.

Note: The desktop software clustering algorithm does not call genotypes if all the samples are one
genotype (form one cluster).

View and assess the Allelic Discrimination Plot
You can view and assess the Allelic Discrimination Plot in the Results tab.
If no data are displayed in the Results tab, click Analyze.

1. In the Results tab, select Allelic Discrimination Plot from the dropdown list.

2. Click ® to configure the plot, then make the following selections:

* SNP Assay: select the assay of interest
* Plot Type: Cartesian or Polar

The Allelic Discrimination Plot is displayed for the selected SNP assay.

Note: Initially, all points in the plot are cyan because all of the wells in the :i Plate Layout are
selected. Click anywhere in the plot or i Plate Layout to deselect all wells. The data points in
the plot change to the call colors.

3. Confirm that control data clusters as expected.

a. Inthe = Well Table or :i Plate Layout, select the wells containing a control to highlight the
corresponding data points in the plot.
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b. Check that the data points for each genotype control cluster along the expected axis of the
plot.

4. Select the cluster at the bottom-left corner of the plot, then confirm that only the negative control
wells are selected in the i Plate Layout or = Well Table.

Samples can unexpectedly cluster with the negative controls for one of the following reasons.
* Samples contain no DNA.
® Samples contain PCR inhibitors.

* Samples are homozygous for a sequence deletion.

5. Review the other clusters in the plot.
a. Click—-drag a box around a cluster to select the associated wells.

b. Confirm that the expected wells are selected in the i Plate Layout or Well Table.

6. Look for outliers outside the three genotype clusters.

3.4
9
2.8
2.4

1.0

14 .b

0a

Allelks 2

0.4

0.3 [IR:] 1.3 1.8 23 28
Allele 1

®Homozygous Allele 1/Allele 1 @ Homozygous Allele 2/Allele 2
® Heterozygous Allele 1/allele 2 XUndetermined

Figure 13 Example Allelic Discrimination Plot

To confirm results, retest outliers and samples with no amplification (cluster with negative controls).

Perform manual calls

68

1. In the Results tab, select Allelic Discrimination Plot from the dropdown list.

2. If the data are not analyzed, click Analyze.

3. (For multiple assays only) Click ®, then select a SNP assay from the dropdown list.

4. In the Allelic Discrimination Plot, use the lasso tool to select the samples to be manually called.
5. Click ®, then select the allele call from the Apply Call dropdown list.

6. Click Analyze.

IMPORTANT! To maintain manual calls after reanalysis, select £ Analysis Settings » Call
Settings, then deselect Default Settings and select Keep Manual Calls from Previous Analysis.
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Note: To remove manual calls, select £ Analysis Settings » Call Settings, deselect Keep
Manual Calls from Previous Analysis, then reanalyze.

Call settings overview (genotyping)

In the Results tab, select £ Analysis Settings » Call Settings to edit the following settings:

¢ Data analysis settings

* Default call settings for SNP assays without custom call settings

® Custom call settings for individual SNP assays

Table 17 Options for data analysis settings (genotyping experiments)

Data analysis setting

Description

Analyze Data from Post-PCR Read Only

Only post-PCR read data is used to determine calls.

Analyze Data from Pre-PCR Read and Post-PCR Read!!]

The pre-PCR read is subtracted from the post-PCR read
to determine calls.

Analyze Real-Time Rn Datal2-3!

The normalized reporter data (Rn) from the user-selected
cycle of the cycling stage is used to determine calls.

Analyze Real-Time Rn - Median (Rna to Rnb)24.3]

A quick baseline-subtracted Rn from the user-selected
cycle of the cycling stage is used to determine calls.
The quick baseline-subtracted Rn is the Rn minus the
median value of the baseline region.

The median subtraction provides improved data
accuracy.

Analyze Real-Time dRn Datal?:3

The regular ARn (dRn) from the user-selected cycle of
the cycling stage is used to determine calls. The ARn
is calculated by subtracting the best-fit line through the
baseline region.

This method is better if the baselines are not flat.

' The run method must include a pre-read stage.
[ Data collection must be on during the PCR stage.

Bl Analysis is not restricted to the last cycle; adjust the analysis cycle using the Reveal Traces feature while viewing the Allelic Discrimination Plot.
¥ Rnato Rnb refers to all the cycles from the Start Cycle Number to the End Cycle Number of the baseline region.

Table 18 Options for call settings (genotyping experiments)

Call setting

Description

Autocaller Enabled

The autocaller algorithm is used to make genotype calls.

Keep Manual Calls from Previous Analysis

If autocaller is enabled, maintains manual calls after reanalysis.

Quality Value

The Quality Value is a proprietary estimation of the likelihood that
a genotyping call is correct (associated with the correct cluster).

If the Quality Value is less than the setting, the call is
undetermined.
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For step-by-step instructions for adjusting the call settings, see the desktop software Help.
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Presence/absence experiments

Overview

Use presence/absence experiments to determine the presence or absence of a target nucleic acid
sequence in a sample.

The software calls the target present or absent based on an algorithmically determined call threshold.
(The call threshold is different from the C; threshold; the C; threshold is not used to make calls.)

Reaction types

Presence/absence reaction types depend on whether the experiment is set up with or without an
internal positive control (IPC).

Presence/absence experiments with IPC (recommended) are multiplex assays for the target
of interest and the IPC target. The IPC is used to confirm that a negative result for the target of
interest is not caused by a failed PCR.

Table 19 Reaction types for presence/absence experiments with IPC

Reaction type (task) Sample description
Unknown Test sample
and
IPC template
Negative control Water or buffer
and
IPC template
No amplification control (NAC; Water or buffer plus a blocking agent
blocked IPC)!"] and
IPC template; amplification prevented by blocking agent

' Minimum of two replicates is required for this control.
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Set up the presence/absence experiment in the software

* Presence/absence experiments without IPC are singleplex reactions.

Table 20 Reaction types for presence/absence experiments without IPC

Reaction type (task) Sample description
Unknown Test sample
Negative control Water or buffer

The software makes calls for individual wells. Running three or more replicates of each reaction can
help identify outlier wells that may be present.

Compatible PCR options

Table 21 PCR options for presence/absence experiments

Single- or multiplex PCR PCR or RT-PCRI! Detection chemistry
Singleplex (without IPC) PCR TagMan™
Multiplex (with IPC) 1-step RT-PCR
2-step RT-PCR

' RT-PCR: reverse transcription-PCR

Presence/absence calls are based on end-point data (data collected after the PCR stage).
* The data collected is the normalized intensity of the reporter dye, or Rn.

* [f end-point experiments include pre-PCR data points, the software calculates the delta Rn (ARn)
value according to the following formula:

ARN = RN (post-PCR read) = RN (pre-PCR read) » Where Rn = normalized readings.

We recommend collecting real-time amplification data during the PCR stage, for troubleshooting
purposes.

Set up the presence/absence experiment in the software

1. Inthe ﬁ Home screen, create or open a template.

* Inthe a& New Experiment pane, click Create New Experiment to create a new template.

* Inthe & Open Existing Experiment pane, click Open to select and open an existing
template.

2. In the Properties tab, enter the template information.

3. In the Method tab, adjust the reaction volume.
For most experiments, the default run method is appropriate.

4. In the Plate tab (Quick Setup), assign plate attributes.
a. In the Plate Attributes pane, select the Passive Reference from the dropdown list.
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Set up and run the PCR reactions

5. In the Plate tab (Quick Setup), define and assign well attributes.
a. Select wells in the i Plate Layout or the = Well Table.

b. Assign samples and targets to selected wells.
* Enter new sample and target names in the text fields.

* Select previously defined samples and targets from the dropdown lists.

Note: New sample or target names entered in the Quick Setup subtab are automatically
populated with default values for Reporter (FAM) and Quencher (NFQ-MGB) and assigned a
task ((I] Unknown). Edit these values in the Advanced Setup subtab.

6. (Optional) In the Plate tab (Advanced Setup), assign tasks.
a. Select wells in the i Plate Layout or the = Well Table.

b. In the Targets table, select the checkbox of a target, then select a task from the dropdown

list.
Reaction type Target Task
Target of interest U |
Unknown (test sample)
IPC
Target of interest L
Negative control
IPC
Target of interest L
NAC (blocked IPC)
IPC

Set up and run the PCR reactions

1. Assemble the PCR reactions. Follow the manufacturer's instructions for the reagents and follow
the plate layout set up in the software (see “Prepare reactions” on page 21).

2. In the desktop software, open the appropriate template (EDT file).

3. Load the reaction plate into the instrument and start the run (see “Start and monitor a run” on
page 23).
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Review results

Workflow: Review presence/absence experiments

Assess the Presence/Absence Plot (page 75)
v
(Optional) View the Amplification Plot (page 31)
v
Review data for outliers and (optional) omit wells (page 34)
v
(Optional) View the Multicomponent Plot to review the dye signal profile (page 37)
v
(Optional) View the Raw Data Plot to review the signal profile (page 38)
v
(Optional) Review flags in the QC Summary (page 39)
v

(Optional) Configure the analysis settings (page 76, page 103)

IMPORTANT! If you omit wells or configure the analysis settings, click Analyze to reanalyze the data.

Presence/Absence Plot overview

The Presence/Absence Plot displays the intensity of the fluorescence for each well.

Review the Presence/Absence Plot to confirm that amplification in the control wells is as expected and
to review the calls for the unknown samples.

Table 22 Expected results for control reactions

Reaction type Target Result Call
Negative control IPC Amplification IPC Succeeded
Target of interestl!] No amplification Negative control
NAC (blocked IPC) IPCI2] No amplification Blocked IPC Control
Target of interest No amplification Negative control

' The target threshold is calculated from the negative control reactions.
] The IPC threshold is calculated from the NAC reactions.
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Table 23 Criteria for calls in unknown reactions

Target signal IPC Signal Call
Above the target threshold Above or below the IPC threshold Presence
Below the target threshold Above the IPC threshold Absence
Below the target threshold Below the IPC threshold Unconfirmed

View and assess the Presence/Absence Plot

You can view and assess the Presence/Absence Plot in the Results tab.

If no data are displayed in the Results tab, click Analyze.

1. In the Results tab, select Presence/Absence Plot from the dropdown list.

2. Click ® to configure the plot, making the following selections:

* Target Reporter: target defined for the target of interest
¢ Control Reporter: target defined for the IPC
* For the initial review of the Presence/Absence Plot, select the following options:
— Show Calls: All Calls
— Show IPC
— Show Controls
The Presence/Absence Plot is displayed for data points selected in the plot settings. The data

points for selected wells in the i Plate Layout or = Well Table are highlighted in the plot (see
Figure 14).

3. Confirm that amplification in the negative and blocked IPC control wells is as expected. Use one of
the following options:

* Select control wells in the i Plate Layout or = Well Table, then confirm the location of the
data points in the Presence/Absence Plot.

* Inthe = Well Table, select Group By » Task, then examine the wells with the Blocked IPC
(l#])and NTC (D ) tasks. The Cq (C; or Cy) values should be Undetermined.

* View the amplification plots for the negative controls (see Figure 15 and “Optimize display of
negative controls in the Amplification Plot” on page 35).

4. Inthe Presence/Absence Plot, view the signal intensity and calls for the unknown samples.

Use the plot settings (click ®) to filter out the IPC results and control wells, or to select only one
type of call.
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The IPC results are not displayed in this example.
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Figure 15 Example Amplification Plot for negative control and blocked IPC

Amplification of the IPC target (blue lines) is seen in the negative control wells but not the blocked IPC (NAC) wells. No
amplification of the target of interest (red lines) is seen in either negative control or blocked IPC wells.

Call settings overview (presence / absence)

Use the Call Settings tab to edit the following settings:
¢ Data analysis settings
* Default call settings for assays without custom call settings
® (Custom call settings for individual assays

Table 24 Options for data analysis settings (presence/absence experiments)

Data analysis setting Description

Analyze Data from Post-PCR Read Only Only post-PCR read data is used to determine calls.

Analyze Data from Pre-PCR Read and Post-PCR The pre-PCR read is subtracted from the post-PCR
Read read to determine calls.
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Table 25 Options for call settings (presence/absence experiments)

Call setting Description

Confidence Value What confidence value is used to determine the target and IPC call

thresholds.

* Alower confidence value or more controls typically results in a

lower calculated threshold.

* A higher confidence value or fewer controls typically results in a

higher calculated threshold.

For step-by-step instructions for adjusting the call settings, see the desktop software Help.
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Overview

Use melt curve experiments to determine the melting temperature (T,,) of the amplification products of a
PCR that used intercalating dyes.

Melting temperature (T, is the temperature at which 50% of the DNA is double-stranded and 50% is

dissociated into single-stranded DNA. The melt curve of a single amplification product displays a single
peak at the product's T,,. Multiple peaks in a melt curve experiment indicate additional amplification
products, usually from non-specific amplification or formation of primer-dimers.

In the software, melt curve analysis is included in the default run method for any experiment type that

uses intercalating dyes.

1.

The software plots a melt curve based on the fluorescence of the dye with respect to change in
temperature.

2. Using the melt curve, the software calculates the melting temperature (T,,).

Reaction types

78

Table 26 Reaction types for melt curve experiments

Reaction type (task) Sample description
Unknown Previously run PCR reactions that used intercalating dyes
No-template control (NTC/ Previously run PCR reactions that used water or buffer
Negative Control) Note: No DNA should be present in NTC wells.
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Set up a melt curve experiment in the software

Set up a melt curve experiment in the software

1. Inthe ﬁ Home screen, create or open a template.

* Inthe &% New Experiment pane, click Create New Experiment to create a new template.

* Inthe & Open Existing Experiment pane, click Open to select and open an existing
template.

2. In the Properties tab, enter the template information.

3. In the Method tab, adjust the reaction volume.

(Optional) Edit the ramp increment in the melt curve (see “Edit the ramp increment for the melt
curve dissociation step” on page 94).

4. In the Plate tab (Quick Setup), assign plate attributes.
a. In the Plate Attributes pane, select the Passive Reference from the dropdown list.

5. In the Plate tab (Quick Setup), define and assign well attributes.
a. Select wells in the i Plate Layout or the = Well Table.

b. Assign samples and targets to selected wells.
* Enter new sample and target names in the text fields.
* Select previously defined samples and targets from the dropdown lists.

Note: New sample or target names entered in the Quick Setup subtab are automatically
populated with default values for Reporter (FAM) and Quencher (NFQ-MGB) and assigned a
task ([I] Unknown). Edit these values in the Advanced Setup subtab.

6. (Optional) In the Plate tab (Advanced Setup), assign tasks.
a. Select wells in the i Plate Layout or the = Well Table.

b. In the Targets table, select the checkbox of a target, then select a task from the dropdown

list.
Reaction type Task
Unknown (test sample) m
No-template control D
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Set up melt curve reactions

Melt curve experiments are performed using previously amplified PCR products, usually at the end of

the PCR run method. You can also use a plate from an intercalating dyes-based PCR run on another
instrument.

Review results

Workflow: Review melt curve experiments

Assess the Melt Curve Plot (page 81)
v
(Optional) View the Multicomponent Plot to review the dye signal profile (page 37)
v
(Optional) View the Raw Data Plot to review the signal profile (page 38)
v
(Optional) Review flags in the QC Summary (page 39)
v

(Optional) Configure the analysis settings (page 82, page 103)

IMPORTANT! If you omit wells or configure the analysis settings, click Analyze to reanalyze the data.

80 QuantStudio™ Design and Analysis GC Software v1.0 User Guide



Chapter 8 Set up, run, and review melt curve experiments &
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Melt Curve Plot overview

The Melt Curve Plot displays the melt curve of the amplification products in the selected wells.

Review the Melt Curve Plot to confirm that the amplification products in a well display a single melting
temperature (T,,). Multiple peaks in a melt curve indicate non-specific amplification or primer-dimer
formation.

Table 27 Melt Curve plots

Plot Description

Derivative Reporter vs. Displays the derivative reporter signal in the y-axis as a function of
Temperature temperature.

The peaks in the plot indicate significant decrease in SYBR™ Green
signal, and therefore the T,, of the amplified products. Use this plot to
confirm a single T, of the amplification products.

Normalized Reporter vs. Displays the fluorescence signal from the reporter dye normalized to
Temperature the fluorescence signal of the passive reference, as a function of
temperature.

You can use this plot to check the quality of the fluorescence data.

View and assess the Melt Curve Plot

You can view and assess the Melt Curve Plot in the Results tab.

If no data are displayed in the Results tab, click Analyze.

1. In the Results tab, select Melt Curve Plot from the dropdown list.

2. Click ® to configure the plot, making the following selections:

¢ Plot Type: Derivative Reporter
¢ Color: Sample, Target, or Well
* Target: All or a target of interest

® (For custom experiments with more than one Melt Curve stage) Select the Melt Curve stage to
view.

The Melt Curve Plot is displayed for the selected wells of the selected stage.

3. Review the plot for evidence of unexpected multiple peaks, which can indicate non-specific
amplification or formation of primer-dimers.

4. Review the = Well Table for the calculated T,, in each well.
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Figure 16 Example Melt Curve Plot

Melt curve settings overview

Use the Melt Curve Settings tab to enable or disable the Multi-Peak Calling function and adjust the
detection levels for additional peaks, if needed.

* Enable or disable Multi-Peak Calling.

Multi-Peak Calling

Description

Enabled — More than one PCR product is expected to amplify.
- T, will be determined for more than one peak.
Disabled — Asingle PCR product is expected to amplify.

- T, will be determined for one peak.

® (For multi-peak calling only) Adjust the detection levels for additional peaks.

Option

Description

Peak level relative to the
dominant peak (%)

Specify a fractional-level value as the additional peak detection
threshold. The detected peaks are measured relative to the height of
the tallest peak, which has a perfect fractional level of 100%. The
default value is 10%.

For example, set a fractional-level detection threshold value at 40, then
peaks above 40% of the tallest peak are reported, and peaks below
40% are regarded as noise.

Peak Calling Threshold

Specify an absolute fluorescence-level value as the peak calling
threshold. The absolute fluorescence is measured on the derivative
reporter (-dRn') axis. Only peaks that appear above the peak calling
threshold will be detected.

For example, set a fluorescence-level value at 90,000, then peaks with
fluorescence above 90,000 are reported, and peaks below 90,000 are
regarded as noise.

For step-by-step instructions for adjusting the melt curve settings, see the desktop software Help.
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Load and unload a plate in the QuantStudio™ 1 Plus Real-Time PCR Instrument

Power on the instrument

Touch anywhere on the touchscreen to determine if the instrument is in sleep mode. If the home

1.
screen is displayed, the instrument is already powered on.

2. If the home screen does not display, power on the
instrument by pressing the switch on the rear panel. ?@% 0o E@ §
— Ll j
If left unattended, the instrument automatically enters sleep & HHHHH]
mode (enabled by default) to conserve power. 2 HHHHHHHF
Note: To customize the sleep mode setting, touch @ HHHHHHH‘ nilinl s
Settings » Instrument Settings » Sleep Mode. 2 [ononononong
© Setting 9 P DHUHDH[%DDDHDD
[l kbl

View run history and delete or transfer files from the
instrument

In the home screen, touch @ Settings » Run History.

¢ Touch an individual run record to view its details, then complete one of the following actions:

— Touch Delete to delete the run record.

— Touch Transfer to export the run data.

¢ Touch Manage to select multiple run records for simultaneous viewing, deletion, or transfer.
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Load and unload a plate in the QuantStudio™ 1 Plus Real-Time PCR Instrument

Note:
. Guests (users not signed-in) can only view guest run records.

. Users signed into their instrument profiles can also view their own run records.
. Administrators can view all run records.

Note: If the connection between the instrument and the desktop software is interrupted during the run,
the instrument still completes the run. However, the run data (EDS file) must be transferred from the
instrument to the desktop software using a USB drive or a network drive.

Load and unload a plate in the QuantStudio™ 1 Plus Real-
Time PCR Instrument

CAUTION! Use flat caps for 0.2-mL tubes. Rounded caps can damage the heated cover.

1. Load the plate.
a. Open the instrument drawer.

b. Load the plate onto the plate adapter so that the following criteria are met.
¢ Well A1 of the plate is in the top-left corner of the plate adapter.

* The barcode faces the front of the instrument.

A1
L

Note: Do not remove the black plate adapter before loading a plate or tube strips. If used,
tube strips can fit loosely in the adapter, but the heated cover will apply the appropriate
pressure to seat the tube strips securely in the adapter.

c. Close the instrument drawer.

2. When the run ends, unload the plate.
a. Open the instrument drawer.

b. Remove the plate.

c. Close the instrument drawer.
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Load and unload a plate in the QuantStudio™ 1 Plus Real-Time PCR Instrument

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the plate temperature
can reach 100°C. Allow it to cool to room temperature before handling.
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Set up a custom experiment

Custom experiments overview

86

Custom experiment setup is required for assays that use multiple PCR stages, such as TagMan"™
Mutation Detection Assays. A custom experiment also allows flexibility for secondary analysis.

The default settings for custom experiments are that of a standard curve experiment, but most settings
are editable.

Table 28 Default settings in custom experiments

Setting Default
Run method (thermal protocol) Equivalent to standard curve experiment default
Unknown [T}
Negative control [ ]
Standard [=]

Baseline threshold equivalent to standard curve experiment default

Flag settings

QC flags on

No automatic omissions

Auto Export

Off
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Set up a custom experiment

Table 29 Editing options in custom experiments

Setting

Description

Run method (thermal protocol)

* Ramp rates can be edited within software limits.

* Data collection can be enabled at any step and during any
ramp within a melt stage.

* Multiple instances of any type of stage can be added, with
exceptions noted.

* Any stage can be added at any point in a run method, with
exceptions noted.
Noted exceptions:
* Only one infinite hold (must be added at the end).

* Only one pre-PCR read and one post-PCR read stage. If
both exist in a run method, the pre-read must be before the
post-read.

For example, the following order is valid: melt-PCR-Pre-Read-Melt—

PCR.
Analysis settings Editable
Flags Editable
Optical filters Editable

Set up a custom experiment in the software

1. Inthe ﬁ Home screen, create or open a template.

* Inthe a& New Experiment pane, click Create New Experiment to create a new template.

* Inthe & Open Existing Experiment pane, click Open to select and open an existing

template.

2. In the Properties tab, enter the template information.

3. In the Method tab, edit the default run method according to the experiment requirements.

4. In the Plate tab (Quick Setup), assign plate attributes.

a. In the Plate Attributes pane, select the Passive Reference from the dropdown list.

5. In the Plate tab (Quick Setup), define and assign well attributes.

a. Select wells in the iii Plate Layout or the

Well Table.
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Assign samples using a sample definition file

b. Assign samples and targets to selected wells.
¢ Enter new sample and target names in the text fields.

* Select previously defined samples and targets from the dropdown lists.

Note: New sample or target names entered in the Quick Setup subtab are automatically
populated with default values for Reporter (FAM) and Quencher (NFQ-MGB) and assigned a
task ([I] Unknown). Edit these values in the Advanced Setup subtab.

6. (Optional) In the Plate tab (Advanced Setup), assign tasks.
a. Select wells in the i Plate Layout or the = Well Table.

b. In the Targets table, select the checkbox of a target, then select a task from the dropdown
list.

7. (Optional) In the Plate tab (Advanced Setup), define and assign biological replicate groups (see
“Define and assign biological replicate groups” on page 98).

Assign samples using a sample definition file

About sample definition files

Import sample information from a sample definition file to include in the plate setup. A sample definition
file is a CSV file or a TXT file that contains the following setup information:

® Sample name

® (Optional) Custom sample properties

Create a sample definition file

1. In a spreadsheet program, create the following column headers:
e Well
e Sample Name

® (Optional) Column header names for up to 32 user-defined custom fields (for example,
Custom 1, Custom 2, etc.)

2. Enter the well number and sample name in the appropriate columns.
3. (Optional) Enter the custom properties for the sample.

4. Save the file as a tab-delimited text file (TXT) or a comma-separated values file (CSV).
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Assign samples and targets using plate setup files

Import sample information from a sample definition file

Example setup files are provided with the software in:

<...>:\Program Files (x86)\Applied Biosystems\QuantStudio Design and Analysis
GC Software\examples\User Sample Files,

where <...> is the drive on which the software is installed.

1. In an open experiment, select File » Import Plate Setup.
2. Click Browse, navigate to a sample definition text file, then click Select.
3. Click Apply.

4. If the experiment already contains plate setup information, the software prompts for the
replacement of the plate setup with the data from the file. Click Yes to replace the plate setup
information.

The samples appear in the Samples table for the experiment. All samples and well assignments in the
experiment are replaced with those in the file. If defined, the custom sample properties also appear in
the = Well Table of the Results tab and in the i Plate Layout tooltips in both the Plate and Results
tabs. The custom fields can be exported with the results data.

Note: To modify custom sample properties information, edit the custom fields in the sample definition
file and import the file again. All of the sample information in the experiment is replaced with the
information in the new file.

Assign samples and targets using plate setup files

About plate setup files

Plate setup files contain setup information such as the well number, sample name, sample color, target
name, dyes, and other reaction plate contents.

Plate setup files can be exported from previously run experiments. For instructions on exporting an
experiment, see “Export experiments or results” on page 41.

Import plate setup data

Import the plate setup for a new experiment from an exported file with one of the following formats:
e EDS - EDS file format
* EDT - user-created and system templates files format
® TXT - text format
e XML - XML format
® (CSV - comma separated values format
* SDT - Sequence Detection System (SDS) template files format
e SDS - 7900 v2.4 format
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Assign targets, samples, and biological replicate groups from an XLS file

Note: Import plate setup information from a 96-well plate into a 384-well plate, provided that the
sample file is a TXT file.

IMPORTANT! The file must contain only plate setup data and it must match the experiment type.

1. In the Plate tab, select File » Import Plate Setup.

2. Click Browse, navigate to and select the file to import, then click Select.

Example setup files are provided with the software in:
<...>:\Program Files (x86)\Applied Biosystems\QuantStudio Design and
Analysis GC Software\examples\User Sample Files,

where <...> is the drive on which the software is installed.

3. Click Apply.
The setup data from the selected file is imported into the open experiment.

Assign targets, samples, and biological replicate groups
from an XLS file

For wells with single targets, you can paste assignment information from an XLS file into the plate layout
of the desktop software.

An example copy and paste file is provided with the software in:

<...>:\Program Files (x86)\Applied Biosystems\QuantStudio Design and Analysis
GC Software\examples\User Sample Files.

where <...> is the drive on which the software is installed.

1. In the custom properties tab of the example Microsoft™ Excel™ file, ensure that the Well column
is sorted in order 1 through 96, then select the Well column and the Sample Name column,
including headers.

Well Table, then ensure that the well numbers are in order

2. In the Plate tab of the software, click
from 1 through 96.

3. Inthe = Well Table, hover the mouse in the first cell underneath the Sample header (adjacent to
A1), right-click, then select either Paste or Paste only samples.
Any of the columns not copied are treated as NULL values for those columns.
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Create new EDT files using existing EDT and EDS files

Create new EDT files using existing EDT and EDS files

About experiment templates
Use templates to create experiments with the same parameters or with pre-existing settings.
Experiments can be saved as unlocked or locked (password-protected) templates.

You can save the following information in an experiment template (EDT) file:

* Plate setup information (defined sample and targets or SNP assays, plate assignment of samples
and targets or SNP assays)

* Reagent information
* Run method (thermal protocol)
* Analysis settings
Example templates are provided with the software in:

<...>:\Program Files (x86)\Applied Biosystems\QuantStudio Design and Analysis
GC Software\templates,

where <...> is the drive on which the software is installed.
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Adjust method parameters

For an overview of the method as it is graphically represented, see “Method elements” on page 18.

¢ In the Method tab, click a method parameter field to edit the following information:

* Reaction volume

* Temperature ramp rate
® Step temperature

e Step hold time

* Number of cycles
* C(Click-drag = to increase or decrease a step temperature.

¢ Click f&y to switch data collection on or off at each step.

Data Collection On enables analysis of data that is collected throughout the PCR, for real-time
analysis and troubleshooting.

¢ Click M to configure pause settings.
* Adjust the heated cover temperature via the instrument settings (see the instrument user guide).

* See the Help to learn more about adjusting the following parameters:

¢ Adding or subtracting a stage
* Adding or subtracting a step from a stage
* Configuring optical filter settings
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Add or adjust a pause step

Add or adjust a pause step

1. In the Method tab, click [ in the step.
2. Select Pause.
3. Enter the cycle after which the pause should occur.

4. Enter a pause temperature between 4°C and 99.9°C.

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the plate temperature
can reach 100°C. If you want to access the plate during a run pause, enter room temperature as
the pause temperature and allow the plate to cool to room temperature before handling.

5.

Click outside of the pause dialog box to return to the method.

o

(Optional) To remove a pause, click [, then deselect Pause.

Select optical filters

The need to edit optical filter settings is rare, and it is intended for advanced or custom uses only. For
information on the dyes read by each filter, see the instrument user guide.

Use the optical filters settings feature to select a filter set to match the profile of a custom dye.

1. In the Method tab, select E’] Action » Optical filter settings.

The excitation (x) and emission (m) wavelengths that correspond to each filter are shown on the
screen.

2. Select the check boxes to enable or disable filters.

A Melt Curve Filter table is accessible if the method contains a melt curve stage. Otherwise, use
the PCR Filter table to select optical filters.

3. (Optional) Click Revert to Defaults to reset filters.

4. Click Close.
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Edit the ramp increment for the melt curve dissociation step

Edit the ramp increment for the melt curve dissociation
step

In the Method tab, you can perform the following tasks to edit the ramp increment for the melt cure
dissociation step.

* Select the ramp increment method for the dissociation step (located under the graphical
representation of the thermal protocol).

Option Description
Continuous (default) Continuously increases the temperature by the ramp increment
(°C/sec).
Step and Hold Increases the temperature by the ramp increment (°C), then holds at
that temperature for the specified time.
No. of Data Points per Increases the temperature by the ramp increment (°C) and collects the
Degree specified number of data points per degree increased.

® (For all options) Edit the temperature ramp increment.
a. Click the ramp increment element in the Dissociation step.

b. Enter a value or use the up/down arrows (default is 0.15°C/s).

® (Step and Hold only) Edit the hold time after each temperature increase.
a. Click the time field next to Step and Hold.

b. Enter a value or use the up/down arrows (default is 5 seconds).

® (No. of Data Points per Degree only) Edit the number of data points to be collected with each
degree increase.

a. Click the number of data points element in the Dissociation step.

b. Enter a value or use the up/down arrows (default is 10 data points).
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Assign well attributes (Quick Setup subtab)

In the Quick Setup subtab, assign well attributes by direct entry into text fields or by selecting user-
defined samples and targets or SNP assays from dropdown lists.

1. In the Plate tab, click Quick Setup.

2. Select plate wells in the i Plate Layout or the

Well Table.

3. Assign the well attributes for the selected wells.

* Into the text fields, enter the names of the new sample and the new target or SNP assay.
* From the dropdown lists, select a user-defined sample and target or SNP assay.

For more information about defining or importing samples and targets or SNP assays, see
“Define and assign well attributes (Advanced Setup subtab)”.

Note: In the Advanced Setup subtab, change the default selections for the reporter and quencher
dyes and for tasks (see “Assign a task to wells” on page 96).

4. (Optional) Enter comments for the selected wells.

Define and assign well attributes (Advanced Setup subtab)

In the Advanced Setup subtab, define or import samples and targets or SNP assays, then assign well
attributes.

1. In the Plate tab, click Advanced Setup.

2. In the Samples table, define samples (see “Define samples in the Samples table” on page 100).
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Assign a task to wells

3. In the Targets or SNP Assays table, define targets or SNP assays, then select detection tasks.

a. Define targets or SNP assays (see “Define targets in the Targets table” on page 101 or “Define
SNP assays in the SNP Assays table” on page 102, respectively).

b. Select a detection task from the Task column dropdown list (see “Assign a task to wells” on
page 96).

4. Assign well attributes.

a. Select plate wells in the i Plate Layout or the
page 19).

Well Table (see “Select plate wells” on

b. Select the checkbox of a defined sample.

c. Select the checkbox of a defined target or SNP assay.

Assign a task to wells

1. In the Plate tab, click Advanced Setup.

2. Select plate wells in the i Plate Layout or the = Well Table (see “Select plate wells” on
page 19).

3. In the Targets or SNPs table, select the check box of a target or SNP assay.

4. Select a detection task from the Task column dropdown list.

Detection tasks for targets and SNP assays

Task Description

m Unknown (default) The well contains test samples with unknown genotype.

D Negative Control / No | The well contains water or buffer instead of sample.
template control

D Standard ["] The well contains samples with known standard quantities.

Note: For a standard detection task, enter the standard quantity in the quantity column.

[] Positive Control The well contains samples homozygous for allele 1.
Allele 1/ Allele 1 1

a Positive Control The well contains samples homozygous for allele 2.
Allele 2 / Allele 2 2]

|E Positive Control The well contains samples heterozygous for allele 1 and 2.

Allele 1/ Allele 2 21

Internal positive The PCR reaction contains a short synthetic DNA template to distinguish between true
control B negative results (that is, the target is absent in the samples) and negative results caused

by PCR inhibitors, incorrect assay setup, or reagent or instrument failure.
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Define and set up standard dilutions

(continued)
Task Description
Blocked IPC [ The well contains an IPC blocking agent, which blocks amplification of the IPC.

NAC - No amplification The PCR reaction contains an IPC blocking agent instead of sample.

control B! S . .
No amplification should occur in negative control-blocked IPC wells because the

reaction contains no sample and amplification of the IPC is blocked.

' For standard curve and relative standard curve experiments only.
[ For genotyping experiments only.
Bl For presence/absence experiments only.

Define and set up standard dilutions

Note: This information is applicable for standard curve and relative standard curve experiments only.

1. Inthe Plate tab, select [#] Action » Define and Set Up Standards.
2. Select Singleplex or Multiplex from the Model dropdown list.
3. (Optional) Select the target from the dropdown list.

4. Enter the parameters for the dilution series.
* Number of dilution points —5 recommended
* Number of replicates —3 recommended
¢ Starting Quantity—The highest or lowest standard quantity, without units.

Note: The quantity can be expressed as copies, copies/uL, ng/pL, or as relative dilutions.

Note: Use E to indicate the exponent number using scientific notation. For example, to
indicate 1.23 x 104, enter 1.23E4.

® Serial Factor

Note: The serial factor calculates quantities for all standard curve points.

— Starting quantity is the highest value—Select 1:10 to 1:2.
— Starting quantity is the lowest value—Select 2x to 10x.

Note: The Standard Curve Preview y-axis values are calculated from the starting quantity and
serial factor. Actual results may differ from the preview.

5. Select and arrange the wells to use for the standards.

* Select Automatically Select Wells for Me.
¢ Select Let Me Select Wells, then select wells using the displayed plate layout.

6. Select to arrange the standards in Columns or Rows.
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Define and assign biological replicate groups

7. (Optional) Click Reset to revert to default values.

8. Click Apply, then click Close to return to the Plate tab.

Assign the standard dilutions manually

Note: Applicable for standard curve and relative standard curve experiments only.

1. In the Plate tab, select wells in the i Plate Layout or = Well Table.
2. Select the check box for the target, select D from the Task dropdown list, then enter a quantity.

3. Repeat to complete the standard dilution series.

Define and assign biological replicate groups

Biological Replicate Groups can be used in standard curve, relative standard curve, comparative C;,
and custom experiments.

1. In the Plate tab, click Advanced Setup.

2. Define Biological Replicate Groups.
a. In the Biological Replicate Groups table, click [+] Add.

b. (Optional) Click a cell to edit color, name, or comments.
c. (Optional) Click X to delete a biological replicate group from the table.

3. Assign Biological Replicate Groups.
a. Select plate wells in the i Plate Layout or the = Well Table (see “Select plate wells” on
page 19).

b. In the Biological Replicate Groups table, select the check box of a biological replicate group.

Sample, target, and SNP assay libraries

Libraries overview

Libraries contain saved information to reuse in future templates.
The following libraries are available in the software:

* Dye Library

* Sample Library

* Target Library

* SNP Assay Library

* Analysis Settings Library
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Sample, target, and SNP assay libraries

To access the libraries, use the Tools menu or the Plate tab.
* |nthe menu bar, select Tools » (Library of choice).

* In the Plate tab of an open EDT or EDS file, click Advanced Setup, then select E', Action » Import
from Library.

Apply a filter to search a library
You can filter the Sample, SNP assay, Target, and Analysis Settings Libraries.

1. Access a library of interest.

* |nthe menu bar, select Tools » (Library of interest).

¢ In the Plate tab of an open EDT or EDS file, click Advanced Setup, then select
[#] Action » Import from Library.

2. Select a feature from the first dropdown list. Each column of the table is an available feature.

3. Select a condition from the second dropdown list to define the feature. The conditions will vary by
feature.

4. Enter a value or text by which to filter.

5. Click Apply Filter.
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Sample, target, and SNP assay libraries

Define samples in the Samples table

100

In the Plate tab, click Advanced Setup, then perform one of the following actions in the Samples

table.

Option

Action

Manually define a
sample

. Click [+] Add.
. Click a cell to edit the attributes for the sample.
3. (Optional) Click 4 in the table header to add a Custom Attribute column.

a. Click the Custom Attribute column header, then edit the header with a
new sample attribute.

b. Click a Custom Attribute cell in the table, then enter the attribute
information.

Import samples from a
TXT or XLS file

. Select [#] Action » Import from File.

Navigate to and select a file, then click Open.

Import samples from the
Sample Library

. Select |,'_'I Action » Import from Library.
2. (Optional) Apply a filter to search for a specific sample (see page 99).
3. Select one or more samples, then click Add Selected.

Note: Shift-click or Cirl-click to select multiple samples.

Save a sample to the
Sample Library

Select a sample row, then select ¢ Action » Save to Library.

Delete a sample from
the table

Select a sample row, then click X.
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Sample, target, and SNP assay libraries

Define targets in the Targets table

In the Plate tab, click Advanced Setup, then perform one of the following actions in the Targets table.

Option Action
Manually define a target 1. Click [+] Add.
2. Click a cell to edit the attributes for the target.
;Tport targets froma TXT or XML | 1 ggject [#] Action » Import from Library.
ile
2. Click Import or Import AIF.
3. Navigate to and select a file, then click Import.
4. Select one or more targets, then click Add Selected.
Note: Shift-click or Ctrl-click to select multiple targets.
:T'fort targets from the Target 1. Select [#] Action » Import from Library.
ibrar
y 2. (Optional) Apply a filter to search for a specific target (see page 99).
3. Select one or more targets, then click Add Selected.
Note: Shift-click or Ctrl-click to select multiple targets.
Save a target to the Target Select a target row, then select |7_'i Action » Save to Library.
Library
Delete a target from the table Select a target row, then click X.
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Sample, target, and SNP assay libraries

Define SNP assays in the SNP Assays table

102

In the Plate tab, click Advanced Setup, then perform one of the following actions in the SNP Assays

table.

Option

Action

Manually define a SNP assay

1. Click [+] Add.
2. Click a cell to edit the attributes for the SNP assay.

Import SNP assays from a
TXT or XML file

Select [#] Action » Import from Library.
Click Import or Import AIF.
Navigate to and select a file, then click Import.

Ao b~

Select one or more SNP assays, then click Add Selected.

Note: Shift-click or Ctrl-click to select multiple SNP assays.

Import SNP assays from the
SNP Assay Library

1. Select E’i Action » Import from Library.

2. (Optional) Apply a filter to search for a specific SNP assay (see
page 99).

3. Select one or more SNP assays, then click Add Selected.

Note: Shift-click or Ctrl-click to select multiple SNP assays.

Save a SNP assay to the
SNP Assay Library

Select a SNP assay row, then [#] Action » Save to Library.

Delete a SNP assay from the
table

Select a SNP assay row, then click X.
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This section describes the analysis settings that apply to all experiment types, unless otherwise noted.

Guidelines for the analysis settings

We recommend analyzing the experiment with the default analysis settings.

If the default analysis settings are not suitable for the experiment, modify the settings in the
Analysis Settings dialog box, then reanalyze the experiment.

Save modified analysis settings to the Analysis Settings Library.

The default analysis settings are different for each type of experiment. The analysis settings determine
for following parameters.

How the baseline, threshold, and threshold cycle (Cy) are calculated
Which flags are enabled
Other analysis options that are specific to a type of experiment

For detailed information about different types of analysis settings, see the following sections.

“Ct settings overview” on page 104

“Flag settings overview” on page 105

“Advanced settings overview” on page 105

“Standard curve settings overview” on page 48

“Relative quantification settings overview” on page 62
“Call settings overview (genotyping)” on page 69

“Call settings overview (presence / absence)” on page 76

“Melt curve settings overview” on page 82
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View and configure the analysis settings

View and configure the analysis settings

1. In the Results tab, click £ (in top-right corner).

2. View and (optional) configure the analysis settings.
For step-by-step instructions for adjusting analysis settings, see the desktop software Help.

3. Click Apply.
4. Click Analyze to reanalyze to experiment with the new settings.
5. (Optional) To save the settings in the Analysis Settings Library, click Save.

6. (Optional) To return to the default settings, click Revert.

C; settings overview

The default C; settings are appropriate for most applications. Configuration of the settings is an option
for analysis of atypical or unexpected run data.

For step-by-step instructions for adjusting the C; settings, see the desktop software Help.

Note: The C; Settings feature is not available for experiments without a PCR stage, such as melt curve
experiments.

Table 30 C; Settings

Setting Description

Data Step Selection Determines the stage/step combination for C; analysis (when there is more than one
data collection point in the run method).

Algorithm Settings - The Baseline Threshold Algorithm is used to calculate the C; values.

Baseline Threshold This algorithm is an expression estimation algorithm that subtracts a baseline

component and sets a fluorescence threshold in the exponential region.

Algorithm Settings — The Relative Threshold (C,;) Algorithm is used to calculate the C,; values.
Relative Threshold
Default C; Settings Determines how the Baseline Threshold Algorithm is set. The Default C; Settings are

used for targets unless they have custom settings.

For recommendations on adjusting baseline and threshold settings, see Table 31.

C; Settings for Target ¢ Default Settings selected—The Default C; Settings are used to calculate the C;
values for the target.

¢ Default Settings deselected—The software allows manual setting of the baseline
or the threshold.

For recommendations for adjusting baseline and threshold settings, see Table 31.
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Flag settings overview

Table 31 Recommendations for manual threshold and baseline settings

Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:

* Above the background.

* Below the plateau and linear phases of the amplification curve.
* Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends before
significant fluorescence signal is detected.

Flag settings overview

Use the Flag Settings to configure the following parameters.
* Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the software for each experiment type.

For step-by-step instructions for configuring the flag settings, see the desktop software Help.

Advanced settings overview

Use the Advanced Settings tab to change baseline settings for individual wells.

For step-by-step instructions for adjusting the advanced settings, see the desktop software Help.

Note: The Advanced Settings feature is not available for experiments without a PCR stage, such as
melt curve experiments.
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Documentation and support

Related documentation

Document Publication number

QuantStudio™ 1 Plus Real-Time PCR Instrument Installation, Use, and 100103661
Maintenance Guide

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
* Worldwide contact telephone numbers
* Product support information
- Product FAQs
- Software, patches, and updates
— Training for many applications and instruments
* Order and web support
* Product documentation
— User guides, manuals, and protocols

— Certificates of Analysis
- Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/home/
global/terms-and-conditions.html. If you have any questions, please contact Life Technologies at
www.thermofisher.com/support.

106 QuantStudio™ Design and Analysis GC Software v1.0 User Guide


http://thermofisher.com/support
http://www.thermofisher.com/us/en/home/global/terms-and-conditions.html
http://www.thermofisher.com/us/en/home/global/terms-and-conditions.html
http://www.thermofisher.com/support

Glossary

biological replicates

Reactions that contain identical components and volumes, but evaluate separate samples of the same
biological source (for example, samples from three different mice of the same strain, or separate
extractions of the same cell line or tissue sample).

For runs that use biological replicate groups in a gene expression project, the values displayed in the
biological replicates lists are calculated by combining the results of the separate biological samples and
treating this collection as a single population (that is, as one sample).

For AC; computations (normalizing by the endogenous control) in a singleplex experiment, the software
averages technical replicates. The averages from the technical replicates are then averaged together to
determine the value for that biological replicate.

endogenous control

A gene that is used to normalize template differences and sample-to-sample or run-to-run variation.

endpoint read
See post-PCR read.

post-PCR read

In genotyping and presence/absence experiments, the part of the instrument run that occurs after
amplification. In genotyping experiments, fluorescence data collected during the post-PCR read
are displayed in the allelic discrimination plot and used to make allele calls. In presence/absence
experiments, fluorescence data collected during the post-PCR read are displayed in the
presence/absence plot and used to make detection calls. Also called endpoint read.

pre-PCR read

In genotyping and presence/absence experiments, the part of the instrument run that occurs before
amplification. The pre-PCR read is optional but recommended. Fluorescence data collected during the
pre-PCR read can be used to normalize fluorescence data collected during the post-PCR read.

reference sample

In relative standard curve and comparative C; (AAC;) experiments, the sample used as the basis for
relative quantification results. Also called the calibrator.

target

The nucleic acid sequence that is amplified and detected during PCR.
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Limited product warranty

task

In the software, the type of reaction performed in the well for the target.

technical replicates

Reactions that contain identical components and volumes, and that evaluate the same sample;
important for evaluating precision.
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